Copyright and Disclaimer

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means electronic, mechanical, photocopying, recording, or otherwise without the prior written permission of CyberLink Corporation.

To the extent allowed by law, POWERDIRECTOR IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY WARRANTY FOR INFORMATION, SERVICES, OR PRODUCTS PROVIDED THROUGH OR IN CONNECTION WITH POWERDIRECTOR AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, EXPECTATION OF PRIVACY, OR NON-INFRINGEMENT.

BY USING THIS SOFTWARE, YOU AGREE THAT CYBERLINK WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, OR CONSEQUENTIAL LOSS ARISING FROM THE USE OF THIS SOFTWARE OR MATERIALS CONTAINED EITHER IN THIS PACKAGE.

The terms and conditions here under shall be governed and construed in accordance with the laws of Taiwan.

PowerDirector is a registered trademark along with other company and product names mentioned in this publication, used for identification purposes and remain the exclusive property of their respective owners.

International Headquarters

Mailing Address   CyberLink Corporation
                 15F, #100, Min Chuan Road, Hsin Tian City
                 Taipei County, Taiwan, R.O.C.

Web Site        www.cyberlink.com

Telephone     886-2-8667-1298

Fax            886-2-8667-1300

Copyright © 2005 CyberLink Corporation. All rights reserved.
Contents

Introduction .............................................................. 1
  Welcome! ..................................................................... 2
  Where to Begin Reading ............................................. 2
  The Movie-Making Process .......................................... 3
    Pre-Production ......................................................... 3
    Putting Your Story Together .................................... 3
    Editing .................................................................... 4
    Producing and Burning Your Movie ............................. 4
  Register Your Software ............................................... 5
  CD-Key Activation ....................................................... 6
  Upgrade Your Software ................................................ 7
  Uninstall Your Software ............................................... 8
    Uninstall from the Start Menu ................................... 8
    Uninstall from the Control Panel ............................... 8
Latest Features ............................................................ 9
  The PowerDirector Program ......................................... 10
    PowerDirector Modes .............................................. 11
    PowerDirector Projects .......................................... 11
System Requirements .................................................. 13
PowerDirector Versions .................................................... 14

Capturing Media ......................................................... 15
  Capture Mode ............................................................ 16
  Capture Preferences .................................................... 17
  Capture Options ......................................................... 18
    Capture Limit Options .............................................. 18
    Profile Options ....................................................... 19
    Analog Video Capture Options ................................. 20
    Audio Capture Options ............................................. 21
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Webcam Video Capture Options</td>
<td>22</td>
</tr>
<tr>
<td>CD/Microphone Capture Profile Setup</td>
<td>23</td>
</tr>
<tr>
<td>Captured Clip Options</td>
<td>23</td>
</tr>
<tr>
<td>Capture from DV Camcorder</td>
<td>25</td>
</tr>
<tr>
<td>Capture a Single Scene</td>
<td>25</td>
</tr>
<tr>
<td>Batch Capture</td>
<td>27</td>
</tr>
<tr>
<td>Capture from HDV Camcorder</td>
<td>34</td>
</tr>
<tr>
<td>Capture from TV</td>
<td>36</td>
</tr>
<tr>
<td>Capture from Digital TV</td>
<td>38</td>
</tr>
<tr>
<td>Capture from Webcam</td>
<td>40</td>
</tr>
<tr>
<td>Capture from Microphone</td>
<td>41</td>
</tr>
<tr>
<td>Rip Audio Tracks from CD</td>
<td>43</td>
</tr>
<tr>
<td>Record a Voice-Over</td>
<td>44</td>
</tr>
<tr>
<td>Add Text Captions</td>
<td>46</td>
</tr>
<tr>
<td>Creating Your Story</td>
<td>47</td>
</tr>
<tr>
<td>Working with Project Files</td>
<td>48</td>
</tr>
<tr>
<td>Create a New Project</td>
<td>48</td>
</tr>
<tr>
<td>Save a Project</td>
<td>48</td>
</tr>
<tr>
<td>Open an Existing Project</td>
<td>48</td>
</tr>
<tr>
<td>New Workspace</td>
<td>48</td>
</tr>
<tr>
<td>View Project Properties</td>
<td>49</td>
</tr>
<tr>
<td>Preferences</td>
<td>50</td>
</tr>
<tr>
<td>File Preferences</td>
<td>50</td>
</tr>
<tr>
<td>General Preferences</td>
<td>51</td>
</tr>
<tr>
<td>Editing Preferences</td>
<td>52</td>
</tr>
<tr>
<td>Confirmation Preferences</td>
<td>52</td>
</tr>
<tr>
<td>Produce Preferences</td>
<td>53</td>
</tr>
<tr>
<td>Set the Project’s Aspect Ratio</td>
<td>54</td>
</tr>
<tr>
<td>The Library</td>
<td>55</td>
</tr>
<tr>
<td>Media Room</td>
<td>56</td>
</tr>
<tr>
<td>Effect Room</td>
<td>56</td>
</tr>
<tr>
<td>Title Room</td>
<td>56</td>
</tr>
<tr>
<td>Transition Room</td>
<td>56</td>
</tr>
<tr>
<td>Audio Mixing Room</td>
<td>57</td>
</tr>
<tr>
<td>Voice-Over Recording Room</td>
<td>57</td>
</tr>
<tr>
<td>Chapter Setting Room</td>
<td>57</td>
</tr>
</tbody>
</table>
Managing Media in the Library ......................................58
Import Clips into the Library ......................................58
Sort Clips in the Library ............................................59
Remove a Clip from the Library ..................................60
Rename a Clip in the Library .....................................61
Restore a Clip’s Original File Name ............................61
View Clip Properties .................................................62
Detect Scenes in a Video Clip ...................................63
Managing Clips in the Workspace .................................65
Timeline View ..........................................................65
Storyboard View ......................................................68
Add a Clip to the Workspace .....................................69
Move a Clip in the Workspace ....................................73
Select Clips in the Workspace ....................................73
Cut/Copy/Paste a Clip in the Workspace .......................73
Align Clips in the Timeline .......................................74
Remove a Clip from the Workspace ............................75
Replace an Effect in the Timeline ...............................75
Set Chapters ................................................................76
Viewing SVRT Information .............................................78
Preview Your Movie ......................................................79
Preview Your Movie in the Preview Window ...............79
Preview Your Movie in the Media Viewer ...................80

Editing Clips ................................................ 81

Editing Media Clips ......................................................82
Split a Clip ..............................................................82
Trim a Video or Audio Clip .......................................83
Mute an Entire Media Clip .......................................88
Mute an Entire Track ...............................................88
Take a Still Snapshot of a Video Clip .........................88
Change the Speed of a Video Clip ............................89
Stretch the Audio Portion of a Video Clip ...................90
Change the Color of a Visual Media Clip ..................90
Edit an Image Clip in PhotoNow! ..............................91
Set a Video Clip’s Interlacing Format .........................92
Adjust a Video Clip’s Aspect Ratio ............................93
Change Audio Clip Volume Levels ............................95
Add a Fade Effect to an Audio Clip ...................................... 97
Restore an Audio Clip’s Volume Levels .................................... 97
Using Magic Tools .............................................................. 98
  Magic Clean ..................................................................... 99
  Magic Motion ................................................................. 103
  Magic Cut ...................................................................... 104
  Magic Fix ...................................................................... 105
  Magic Style ................................................................. 107
  Magic Music ................................................................. 108
Modifying Effects .................................................................. 110
  Set an Effect’s Duration .................................................. 111
  Modifying a Video Effect .................................................. 113
  Modifying a PiP Effect ...................................................... 114
  Modify a Title Effect ....................................................... 124
Preview a Clip ................................................................ 136
  Preview Window ............................................................ 136
  Media Viewer .................................................................. 138

Producing Your Movie ......................................................... 141
  Production Mode .......................................................... 142
  The Production Wizard .................................................... 143
Create a File ...................................................................... 145
  Create an AVI File ........................................................ 145
  Create a DivX File ........................................................ 150
  Create an MPEG-1/MPEG-2 File ....................................... 152
  Create a PSP File (Optional) ........................................... 154
  Create an AVC File (Optional) ......................................... 156
  Create/Modify a Profile .................................................. 159
Create a Streaming File ........................................................ 166
  Create a WMV File for Streaming ..................................... 166
  Create a RealVideo File for Streaming .............................. 168
  Create aQuickTime File for Streaming .............................. 171
Write Back to DV Tape ....................................................... 175

Creating Disc ................................................................. 179
  Create Disc Mode .......................................................... 180
  Customize Your Disc’s Menu Page .................................... 181
## Contents

Burn to Disc ...............................................................188  
Set Your Burning Configuration ..............................188  
Burn Your Movie to Disc ........................................190  

### Appendix ................................................... 193

Technical Support ..........................................................194  
Web Support ............................................................194  
Fax Support .............................................................194  
Telephone Support ................................................195  
Hotkeys .................................................................196  
FAQ .................................................................205  
SVRT2: When Can I Use it? ........................................209  
Disc Types & Formats ..................................................210  
Disc Types .............................................................210  
Disc Type/Format Compatibility ..................................214  
Video Formats & Qualities ..........................................215  
TV Formats ............................................................215  
Video Qualities .......................................................216  
Glossary .................................................................217  
Licensing and Copyright Notices .................................222  
License Disclaimer .....................................................223  
Downloading Source Code .........................................223  
List of Components ....................................................224  
Licenses and Copyrights .............................................225  
Dolby Laboratories .......................................................225  
Intel License Agreement For Open Source Computer Vi- 

sion Library ..............................................................225  
GNU Lesser General Public License ............................226  
CLAPACK Copyright Notice ........................................238  

Index .............................................................................239
Chapter 1:

Introduction

This chapter introduces CyberLink PowerDirector and the digital video editing process. It provides a discussion of the different kinds of technology you will use in the digital movie-making process, as well as system requirements for working smoothly with CyberLink PowerDirector.

This chapter contains the following sections:

- Welcome! on p.2
- The Movie-Making Process on p.3
- Register Your Software on p.5
- CD-Key Activation on p.6
- Upgrade Your Software on p.7
- Uninstall Your Software on p.8
- Latest Features on p.9
- The PowerDirector Program on p.10
- System Requirements on p.13
- PowerDirector Versions on p.14
Welcome!

Welcome to the CyberLink family of digital video tools! PowerDirector is a digital video editing program that can help you create professional-looking video movies, complete with music, voice-over, special effects, and transition effects.

If you don’t have experience making movies, don’t worry. CyberLink PowerDirector provides home users with a simple tool to help them do something a little more creative with their home videos. You don’t have to be a video professional or have aspirations of a box office hit to enjoy using PowerDirector.

Where to Begin Reading

Of course, we recommend that you read through the entire User’s Guide for complete information on working with CyberLink PowerDirector. However, some people like to jump in and get working on specific projects. If you are one of those people, please refer to the list below for the page numbers of the information you are looking for.

- If you have questions about the program or the digital movie-making process, start by reading the Introduction on p.1, then check out some of the information in the Appendix on p.193 (in particular, the FAQ on p.205).
- If you want to capture media, read Capturing Media on p.15
- If you want information on using project files and putting your media clips together into a story, start by reading Creating Your Story on p.47.
- If you want to modify your media clips, read Editing Media Clips on p.82.
- If you want to create a disc, read Creating Disc on p.179.
The Movie-Making Process

The digital movie production process involves a combination of artistry and technology, beginning with raw video footage and ending with a movie production. CyberLink PowerDirector provides the easiest way to produce your finished movie and publish it to the medium of your choice.

Pre-Production

Before you edit your movie using CyberLink PowerDirector, you must first create (or gather) its component parts: video clips, photos, music, and narrative voice-overs.

If you collect raw footage yourself with a camcorder or other recording device, you can capture that content in PowerDirector’s Capture mode. PowerDirector has functions for capturing from a DV camcorder, TV, webcam, microphone, or Audio CD. If you want to use files that are already on your computer, simply import them into the Library. However you collect your content, you should have all of the bits and pieces of your movie on hand so that the video editing process goes as smoothly as possible.

Putting Your Story Together

Once you have your raw footage on hand, import it into the workspace in PowerDirector’s Edit mode. The workspace offers both timeline and storyboard views to suit your preferred working method. Add and rearrange clips in the workspace - even lock tracks to avoid making mistakes while you work.
Editing

CyberLink PowerDirector’s Edit mode offers loads of options for editing audio, video, and image files in addition to video transitions, video effects, titles, and PiP effects. You might expect to use the functions in PowerDirector’s Edit mode to perform the following tasks:

1. Condense a long video clip to a desired duration using Magic Cut.
2. Clean up audio, video, and image files using Magic Clean.
3. Add a special effect to a video clip.
5. Adjust the sharpness, contrast, and color of a video clip.
6. Mix your background and voice-over tracks.
7. Add transition effects between video clips.
8. Add a pan or zoom effect to an image using Magic Motion.
10. Automatically generate a movie with video effects, transitions, PiP effects, and titles using Magic Style.
11. Stabilize shaky videos and enhance the focus on blurry photos using Magic Fix.
12. Preview your production.

Producing and Burning Your Movie

After editing your media and creating your movie, it’s time to produce your project. You can choose to make a disc, create a movie file for playback on your computer, create a streaming file for use on the Internet, or write your movie back to DV tape.
Register Your Software

After you install the program, a registration window opens, prompting you to register your product. It is important to register your software in order to receive technical support or other information from CyberLink.

To register your software, do this:

1. Enter your personal information in the **First Name**, **Last Name**, and **Email** entry boxes.
   - Check one or both of the options to receive information from CyberLink, or uncheck if you do not wish to receive this information.

2. Click **Register Now**.
   - If you would like to register this product at a later time, click **Remind Me Later**. The registration box will open each time you run the program until you register.
CD-Key Activation

The first time you run PowerDirector, you are prompted to upgrade immediately from the trial version to the version you have purchased.

To upgrade PowerDirector to the version you have purchased, do this:

1. Open PowerDirector.
2. The Activation dialog box appears.
3. Enter your activation key, then click OK.

Note: You can copy and paste your activation key into the first entry field.
Upgrade Your Software

Software upgrades may be periodically available from CyberLink. To upgrade your software, click on the Tool bar. The Upgrade window will open and you can select to download new upgrades and patches. You will be redirected to CyberLink’s cyberstore if you choose to purchase new upgrades.

Note: You must be connected to the Internet to use this feature.
Uninstall Your Software

If you need to uninstall your CyberLink software for any reason, you can do so either from the Windows Start menu or from the Windows Control Panel.

Uninstall from the Start Menu

To uninstall your CyberLink software from the Start menu, do this:

1. Click **Start** > **Programs** > [name of CyberLink software package] > **Uninstall** [product name]. The uninstall wizard opens.
2. Follow the uninstall wizard to remove the program.

Uninstall from the Control Panel

To uninstall your CyberLink software from the Control Panel, do this:

1. Click **Start** > **Settings** > **Control Panel**.
2. Double-click **Add or Remove Programs**.
3. Select the program name, then click **Change/Remove**.
4. Follow the uninstall wizard to remove the program.
Latest Features

This section describes the latest features in the CyberLink PowerDirector program.

Capture

- Support for HDV devices
- Support for true 16:9 widescreen DV/HDV capture
- Text captions on captured DV/TV videos

Edit

- Output previews by tracks
- Adjustable preview quality
- New Magic Style for automatic timeline generation
- Enhanced Magic Fix to correct shaky videos and blurry photos
- Enhanced Magic Clean to instantly correct color temperature
- Enhanced Magic Motion for custom pan and zoom effects
- New and improved visual effects and titles
- Enhanced RichVideo support

Produce

- Support for true 16:9 widescreen production
- Support for Sony PSP video output (optional)
- Support for AVC-MPEG4 video output (optional)

Other

- New Create Disc mode for enhanced integrated authoring
- Support for HD-MPEG video, AVC-MPEG4 (optional), and Sony PSP (optional) video formats
The PowerDirector Program

When you first open PowerDirector, the program appears as follows:

- **Edit function buttons**: Open editing rooms dedicated to a specific task.
- **Mode buttons**: Click to switch working modes.
- **Library**: Contains media clips as well as the various effect and media ‘rooms’.
- **Preview window**: Provides playback controls to preview clips and movies.
- **Magic Tools**: Provide easy ways to work with media clips.
- **Media tracks**: Insert media clips here.
- **Function buttons**: Provide shortcuts to common functions.
PowerDirector Modes

PowerDirector has separate modes that enable you to perform different tasks: Capture, Edit, Produce, and Create Disc.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capture</td>
<td>Click to switch to the capture interface. See Capturing Media on p.15.</td>
</tr>
<tr>
<td>Edit</td>
<td>Click to switch to the editing interface. See Editing Clips on p.81.</td>
</tr>
<tr>
<td>Produce</td>
<td>Click to switch to the production interface, which opens the Disc Wizard. See Producing Your Movie on p.141.</td>
</tr>
<tr>
<td>Create Disc</td>
<td>Click to switch to the authoring interface. See Creating Disc on p.179.</td>
</tr>
</tbody>
</table>

By default, the program opens in Edit mode. However, the PowerDirector program changes appearance depending on mode. In addition, certain parts of the program may change within a specific mode. For example, the Library changes display when you click an editing function button, and the workspace can toggle between Timeline and Storyboard views. The different modes and the varying appearances they bring to the PowerDirector program are all described in the sections that follow.

PowerDirector Projects

Changes you make to your video clips, audio files, or photos in CyberLink PowerDirector do not affect your original media. Since your settings are all saved in the project file, you can trim, edit, or delete clips in PowerDirector, but still keep your original files on your hard drive, untouched. So let yourself get creative! If you end up changing things too drastically, you can always start over.
You can open and save a PowerDirector project file just like any other file in Windows. You can also create a new file or save the current file under a different file name.
System Requirements

The system requirements listed below are recommended as minimums for general digital video production work.

**Screen Resolution:**
- 1024 x 768, 16-bit color or higher

**OS:**
- Windows XP/2000 (Windows XP Service Pack 2 is required for HDV capture)

**Memory:**
- 256 MB required (512+ MB DDR recommended)
- 1 GB DDR2 Ram recommended for HD content editing

**CPU:**
- **Capture/produce AVI:** Pentium 2-450 MHz or AMD Athlon 500 MHz
- **Capture/produce VCD Quality (MPEG-1):** Pentium 3-600 MHz or AMD Athlon 700 MHz
- **Capture/produce DVD Quality (MPEG-2):** Pentium 4-2.2 GHz or AMD Athlon XP 2200+
- **Capture/produce High Quality MPEG-4 and Streaming Videos (WMV, QuickTime, RealVideo, DivX):** Pentium 4 2.4 Ghz or AMD Athlon XP 2400+
- **Produce MPEG-4 AVC and MPEG-2 HD Files:** Pentium 4 3.0 Ghz with HyperThreading or AMD Athlon 64 recommended
- **Edit HD Contents:** Pentium 4 3.0 Ghz Duel Core CPU recommended
- PowerDirector 5 is optimized for CPU with MMX/SSE/SSE2/3DNow!/3DNow! Extension/HyperThreading technology
- PowerDirector 5 editing engine is optimized for Intel Duel Core CPU.

**Video Capturing Device:**
- PCI or USB1.0/2.0 capture device compliant with WDM standard (i.e. PC Camera and TV tuner with WDM driver)
- DV camcorder connected via OHCI-compliant IEEE1394
- DVD camcorder connected via USB2.0
- Sony MicroMV camcorder
- JVC Everio camcorder (GZ-MC100, GZ-MC200)
- Sony HDR-FX1 (HDV)
- Sony HDR-HC1 (HDV)
- JVC GR-HD1U (HDV)

**Hard Disk Space:**
- 5 GB required (400MB for SmartSound Quicktrack Library)
- 10 GB (15 GB recommended) required for DVD production
- 100 GB (7200 rpm) recommended for HD content editing

**CD/DVD Burning Device:**
- CD/DVD burner (CD-R/RW, DVD+R/RW or DVD-R/RW) is required to burn VCD/DVD/SVCD titles

**Microphone:**
- A microphone is required for recording voice-overs.

**PowerDirector Versions**

PowerDirector is available in many different OEM versions and the full retail version. File format support, editing features, disc-making functions, and other features vary depending on the version that you have. For information on the availability of specific functions in the PowerDirector version that you are using, please check the PowerDirector Readme file.
Chapter 2:

Capturing Media

This chapter explains how to acquire media for use in CyberLink PowerDirector. You can acquire video and audio from a wide variety of sources, including a webcam, DV camcorder, HDV camcorder, TV, Digital TV, VCR, microphone, and audio CD.

This chapter contains the following sections:

- Capture Mode on p.16
- Capture Preferences on p.17
- Capture Options on p.18
- Capture from DV Camcorder on p.25
- Capture from HDV Camcorder on p.34
- Capture from TV on p.36
- Capture from Digital TV on p.38
- Capture from Webcam on p.40
- Capture from Microphone on p.41
- Rip Audio Tracks from CD on p.43
- Record a Voice-Over on p.44
- Add Text Captions on p.46
Capture Mode

When you click the **Capture** button, PowerDirector enters Capture mode, in which you can capture media from a variety of capture devices. In Capture mode, the program appears as follows:

- **Capture device selection area**: Allows you to switch capture devices and set capture limits.
- **Captured Clips area**: Displays media clips after capture.
- **Capture preview window**: Displays media clips during capture.
- **Information display area**: Displays information about captured file size and available HDD space.
Capture Preferences

Before you begin to capture, make sure your capture environment is set according to your preferred working methods.

To set your capture preferences, click **Edit > Preferences**. The Preferences dialog box opens. Available options are as follows:

- **Add captured files to Library**: Check this option to import captured files into the Library after capture.
- **Add captured files to workspace**: Check this option to import captured files into the workspace after capture.
- **Use video overlay for capture**: Keep this option checked during capture unless you have an older VGA card that does not support video overlay. (Unchecking this option in this event avoids the unsupported overlay display error.)
- **Enable automatic file replacement when recording voice-over**: Check this option to overwrite existing audio if the voice-over overlaps during recording.
- **Do not detect scenes during capture**: Check this option if you do not want to activate the scene detection function during capture.
- **After capture, detect scenes by changing of video frames**: Check this option to perform scene detection during video capture. In scene detection, PowerDirector compares captured frames to decide when there is a scene change. Each scene is saved as a file as recording continues.
- **During capture, detect scenes by timecode, and save each scene as a separate file (DV-VCR mode only)**: Check this option to detect scene-break signals and to save each scene as a separate file. (DV camcorder generate a scene-break signal on the tape whenever users release the REC button.) This feature is only available in DV tape capture.
- **DV Parameters** button: Click this button to set the buffer parameters for your DV camcorder. Setting a buffer time ensures that your DV camcorder and your batch capture or DV writing device begin at the same time. Without a buffer, batch capturing or writing to tape may begin before the camcorder is engaged.
Capture Options

Many of the options for capturing are shared by different capture modes. These options are described below. Not all of the options described in this section are available in all capture modes. Descriptions of options specific to a single capture mode are found in the section that describes that mode.

Note: PowerDirector's capture functions vary, depending on version. For information on the availability of specific features in the PowerDirector version that you are using, please check the Readme file.

Capture Limit Options

You can set limits on the size or duration of video that PowerDirector captures. When the limit you set is reached, capture automatically stops.

To set a maximum capture length, check Time limit, then enter a time in the timecode box.

To set a maximum captured file size, check Size limit, then enter a size limit (in MB).
Profile Options

Click **Profile**. The Profile Setup dialog box opens.

![Profile Setup Dialog Box]

**Note:** For information on selecting a profile, see Create/Modify a Profile on p.159.

- Click the **Comments** and **Details** buttons for more information about the profile.
Analog Video Capture Options

Click Video. The Analog Video Settings dialog box opens, displaying the Video Setup tab. You may select your capture source here.

Click the Adjust Video tab and set the video options, if necessary.

Click the TV Setup tab and set the TV options, if necessary.
Audio Capture Options

Before you capture from microphone, there are several options you can set.

Drag the volume level slider to set the input volume level.  
Check Begin with fade-in to start an audio capture in with a fade-in from silence.  
Check End with fade-out to end an audio capture with a fade-out to silence.  
Click Audio. The Audio Setup dialog box opens. You may select your audio input device, audio input source, and input volume here.
Webcam Video Capture Options

When capturing from a webcam, click **Video** to set up your webcam capture profile. Under the Video Setup tab, you can select your capture source. Click **Advanced Settings** for more options.

**Note:** Advanced settings may differ depending on the webcam you are using. Please refer to your webcam’s user guide to configure advanced settings for it.
CD/Microphone Capture Profile Setup

When recording from CD or microphone, click Profile to set up your CD or microphone recording profile. You may select an audio quality here.

- You can save a profile using a unique name by clicking the Save As... button. Click Remove to remove the new profiles you create.

Captured Clip Options

After you capture clips, a number of options are available for managing them. Some of these options appear in the dialog box immediately after capture, while others are available in the Captured Clips area of the Capture window.

Click Change Folder to set a different destination folder for captured clips.

Note: Set this option before capturing clips.
Post-Capture Options

To delete a captured file, click **Delete** in the dialog box that appears after recording.

To name a captured file, enter a name in the dialog box that appears after recording. To use default names for captured files, check the **Don’t ask me to rename files again** option in the dialog box that appears after recording.

Captured Clips Area Options

Captured clips appear in the Captured Clips area. Right-clicking clips in this area displays a menu that provides several options:

- **Delete from Disk**: Select this option to remove the clip from the Detected Scenes area and delete the source file from your hard disk.
- **Remove Item**: Select this option to remove the clip from the Detected Scenes area.
- **Play in Media Viewer**: Select this option to view the clip in the Media Viewer. See Preview a Clip in the Media Viewer on p.139.
- **Detect Scenes**: Select this option to detect the scenes contained in a video clip. See Detect Scenes in a Video Clip on p.63.
**Capture from DV Camcorder**

DV camcorders are popular among video hobbyists, as they record in a digital format that does not require conversion before being used on a computer, and often provide a number of advanced recording options. You can capture a single scene or a number of scenes in a batch from your camcorder. Procedures for both methods are described below.

**Capture a Single Scene**

You can capture a single segment of video from your camcorder. This function is particularly useful, for example, if you want to acquire a long video segment in its entirety without skipping over sections.

To capture a single scene from a DV camcorder, do this:

**Note:** Make sure your camcorder is in VCR mode before capturing.

1. Click ![Capture](#) to open Capture mode.
2. Click 📹 to open the DV camcorder capture function. (You may have to wait a few moments as PowerDirector switches devices.)

3. Locate the position at which you would like to begin capturing. You may do this in one of the following ways:
   - Use the playback buttons.
   - Drag the time slider.
   - Enter a timecode, then click 🕒 to seek to that timecode.

4. Set your capture options (if necessary). See Capture Options on p.18.
   - Check **Non-realtime** to continue processing captured video after the original video stops playing in order to ensure that no frames are dropped. Capturing video at a higher speed reduces processing time, but yields video of a lower quality. Capturing better quality video requires more CPU power and more time to complete.

5. Click 🎥 to begin capture. The video plays in the preview window as you capture.
• Click  to stop capture before completion.

6. Enter a name in the dialog box that appears. The clips you have captured appear in the Captured Clips area.

**Batch Capture**

Batch capturing may seem intimidating, but in reality, it is an incredibly convenient method of capturing multiple video clips automatically. If you take a few minutes to familiarize yourself with batch capturing, you will save yourself loads more time when you capture video from your camcorder. PowerDirector scans your DV for intervals (or allows you to set them manually), then captures them in a batch using the intervals you created.

**Automatic Batch Capture**

Automatic batch capture is a quick way to capture scenes from a video tape.

To perform an automatic batch capture, do this:

**Note:** Make sure your camcorder is in VCR mode before capturing.

1. Click  to open Capture mode.
2. Click 📹 to open the DV device capture function. (You may have to wait a few moments as PowerDirector switches devices.)

   - Check **Non-realtime** to continue processing captured video after the original video stops playing in order to ensure that no frames are dropped.

4. Click 🔄. The DV QuickScan dialog box opens.
5. Locate the position at which you would like to begin scanning for intervals. You may do this in one of the following ways:
   - Use the playback buttons.
   - Drag the time slider.
   - Enter a timecode, then click to seek to that timecode.

6. Click **Start** to start scanning for intervals. PowerDirector scans for intervals.

7. Click **Stop** after all of the video segments you want to capture have been scanned. Scanned intervals appear as thumbnails in the window.

   ![Image of QuickScan window]

   - Click **Back** to return to the QuickScan function.

8. Check the thumbnails of the intervals you want to batch capture.
   - You can change the profile of the clips to be captured. To do this, click **Profile** and select a new profile.
   - To combine sequential intervals into a single interval, check the intervals, then click **Merge**. Click **AutoMerge** to combine
intervals to combine all checked intervals in sequence or to merge all of the clips in an interval that you can set.

9. Click **Start** to begin batch capture. PowerDirector rewinds your tape to the position of first clip, then begins capturing all of the intervals you have checked. The video plays in the preview window as you capture. The clips you have captured appear in the Captured Clips area.
   - Click **Stop** to if you want to stop the capture process.

10. Click **Finished** to return to Capture mode.
Manual Batch Capture

Using manual batch capture gives you more control over the capturing process and ensures that the scenes you want to include are captured. Manual batch capturing is recommended when you are sure which scenes you want to capture and have a good idea where they are located on the tape.

To perform a manual batch capture, do this:

**Note:** Make sure your camcorder is in VCR mode before capturing.

1. Click to open Capture mode.

2. Click to open the DV device capture function. (You may have to wait a few moments as PowerDirector switches devices.)

   - Check **Non-realtime** to continue processing captured video after the original video stops playing in order to ensure that no frames are dropped.
4. Click 📂. The DV Manual Scan/Batch Capture dialog box opens.

5. Navigate to the mark in time by doing one of the following:
   - Click inside the timecode box, enter a time using your keyboard, then press the **Enter** key.
   - Use the playback buttons.

6. Click 📕 to set the mark in point.
7. Navigate to the mark out time, then click 🎥 to set the mark out point. The intervals you set appear in the pane to the right of the preview window.

![DV Manual Batch Capture](image)

**Note:** You can continue to set intervals of clips to capture. Each interval, however, must have a duration of at least two frames.

8. Click **Start** to begin batch capture. PowerDirector rewinds your tape to the position of first clip, then begins capturing all of the intervals you have checked. The video plays in the preview window as you capture. The clips you have captured appear in the Captured Clips area.
   - Click **Stop** if you want to stop the capture process.
   - Click **Add** to start another round of batch capturing.

9. Click **Finished** to return to Capture mode.
Capture from HDV Camcorder

HDV camcorders are also quite popular among video enthusiasts, as they record in a digital format that does not require conversion before being used on a computer, and often provide a number of advanced recording options. You can capture scenes from your HDV camcorder into PowerDirector. The procedure is described below.

To capture a single scene from a HDV camcorder, do this:

**Note:** Make sure your camcorder is in VCR mode before capturing.

1. Click **Capture** to open Capture mode.

2. Click **Capture** to open the HDV camcorder capture function. (You may have to wait a few moments as PowerDirector switches devices.)

3. Locate the position at which you would like to begin capturing. You may do this in one of the following ways:
   - Use the playback buttons.
   - Drag the time slider.
• Enter a timecode, then click ✓ to seek to that timecode.

4. Set your capture options (if necessary). See Capture Options on p.18.

5. Click ◼ to begin capture. The video plays in the preview window as you capture.

• Click ◼ to stop capture before completion.

6. Enter a name in the dialog box that appears. The clips you have captured appear in the Captured Clips area.
Capture from TV

You may wish to add segments from your favorite TV programs to your movie production, or simply record other segments for different uses.

To capture from TV, do this:

1. Click \[\text{Capture}\] to open Capture mode.

2. Click \[\text{Capture TV}\] to open the TV capture function. (You may have to wait a few moments as PowerDirector switches devices.)

3. Set your capture options (if necessary).
   - Click \[\text{CATV}\] if you have CATV, or click \[\text{Antenna}\] if your TV has an antenna.

4. Locate the channel you want to capture. You may do this in one of the following ways:
   - Click \[\text{Up Channel}\] to go up a channel or \[\text{Down Channel}\] to go down a channel.
   - Click \[\text{Previous Channel}\] to return to the previous channel.
   - Enter a channel number in the channel box.
5. Click 🔄 to begin capture.

6. Click 🔄 to stop capture.

7. Enter a name in the dialog box that appears. The clips you have captured appear in the Captured Clips area.
Capture from Digital TV

You may wish to add segments from your favorite Digital TV programs to your movie production, or simply record other segments for different uses.

To capture from Digital TV, do this:

1. Click \( \text{Capture} \) to open Capture mode.

2. Click \( \text{Capture} \) to open the Digital TV capture function. (You may have to wait a few moments as PowerDirector switches devices.)

3. Set your capture options (if necessary).
   - Click \( \text{Capture} \) if you have not yet setup your digital TV channel.

4. Locate the channel you want to capture. You may do this in one of the following ways:
   - Click \( \text{Channel Up} \) to go up a channel or \( \text{Channel Down} \) to go down a channel.
   - Click \( \text{Return} \) to return to the previous channel.
   - Enter a channel number in the channel box.
5. Click \( \) to begin capture.

6. Click \( \) to stop capture.

7. Enter a name in the dialog box that appears. The clips you have captured appear in the Captured Clips area.
Capture from Webcam

Webcams (also known as PC cameras) are inexpensive, handy video cameras that you can use for simple video capturing.

To capture from webcam, do this:

1. Click to open Capture mode.

2. Click to open the webcam capture function. (You may have to wait a few moments as PowerDirector switches devices.)


4. Click to begin capture.

5. Click to stop capture.

6. The clips you capture appear in the Captured Clips area.
Capture from Microphone

Your movie may require a narrative voice-over, or you may elect to record dialog in a studio for better acoustics. No matter what kind of audio tracks you record, they can be captured with a microphone for use in your PowerDirector project.

To capture from microphone, do this:

1. Click \( \text{Capture} \) to open Capture mode.

2. Click \( \text{Microphone} \) to open the microphone capture function. (You may have to wait a few moments as PowerDirector switches devices.)

   - Click \( \text{Fade-in} \) to add a fade-in effect.
   - Click \( \text{Fade-out} \) to add a fade-out effect.

4. Set your master audio level. To do this, click \( \text{Master Audio} \), then drag the slider to the desired recording level. (You may also adjust audio levels on the fly while recording.)
5. Click ◆ to begin capture. Recording begins after a three-second countdown.

6. Click ■ to stop capture.
Rip Audio Tracks from CD

Using your favorite music can help you to create a really fun, personalized movie. If you have music stored on an audio CD, you can rip the songs you want and then add them as audio tracks in PowerDirector.

To rip audio tracks from CD, do this:

1. Click to open Capture mode.

2. Click to open the CD capture function. (You may have to wait a few moments as PowerDirector switches devices.)

3. Select a drive.

4. Select the track you want to rip.

5. Set your capture options (if necessary). See Capture Options on p.18.

6. Click to begin capture.

   - Click to stop capture.

7. Enter a file name for the captured file and click OK.
Record a Voice-Over

The Voice-Over Recording Room contains controls for recording a narration from a microphone while watching the video clip the voice-over is destined to accompany. When you capture your narration, the audio track is synchronized with the video portion.

To record a voice-over, do this:

1. Click \( \text{Voice-Over Recording Room} \) to open the Voice-Over Recording Room.
2. Set your voice-over options. See Capture Options on p.18.
   - Click \( \text{Recording options buttons} \) to add a fade-in effect.
   - Click \( \text{Recording options buttons} \) to add a fade-out effect.
3. Locate the point in your movie at which you want to begin recording a voice-over. You may do this in one of the following ways:
   - Drag the Timeline slider.
   - Drag the preview window slider.
   - Use the playback buttons.
• Enter a timecode in the timecode box.

4. Drag the Recording volume level slider to set the input volume level.

5. Click 🎥 to begin recording. Record your voice-over as you watch the video in the preview window.

6. Click 🎬 to stop recording.

7. Click ✗ to close the Voice-Over Recording Room.
Add Text Captions

You may add captions to the DV/TV media clips you wish to capture. Captions can be a date code, time code, or a short remark.

To set your text captions options, go to the TV capture function or DV capture function and click 📺. The Add text overlay on captured video dialog box opens, displaying the Overlay Text tab. Available options are as follows:

- **Add Date Code**: Check this option to add a date code on your captured video. Select a date code format that best fits your need.
- **Add Time Code**: Check this option to add a time code on your captured video. Select a time code format that best fits your need.
- **Add Remark**: Check this option to add a remark on your captured video.

Click the Overlay Format tab. Available options are as follows:

- **Font Type**: Set the font type for your text captions.
- **Font Size**: Set the font size and color for your text captions.
- **Text Order**: Set the order of the text captions.
- **Text Position**: Set the position where you want the captions to appear in your video.
Chapter 3:

Creating Your Story

This chapter discusses how to work with project files, import media into the Library, and manage clips in both the Library and the workspace. It also describes how to view project information and to preview your movie during production.

This chapter contains the following sections:

- Working with Project Files on p.48
- Preferences on p.50
- The Library on p.55
- Managing Media in the Library on p.58
- Managing Clips in the Workspace on p.65
- Set Chapters on p.76
- Viewing SVRT Information on p.78
- Preview Your Movie on p.79
Working with Project Files

This section describes working with PowerDirector project files. These are the basic commands for managing new and existing projects.

Create a New Project

To create a new project file, click File > New Project. If an unsaved project file is open in the workspace, you are prompted to save it.

Save a Project

To save the current project file, click File > Save Project. (To save the current project file under a different file name, click File > Save Project As....) In the dialog box that opens, enter a file name and location, then click Save.

Open an Existing Project

To open an existing project file, click File > Open Project.... If an unsaved project file is open in the workspace, you are prompted to save it. In the dialog box that opens, locate the project file you want to work with, then click Open.

New Workspace

To clear the workspace of all clips and effects, click File > New Workspace.
View Project Properties

You can view such project properties as the creation date, the author’s name, associated keywords, etc.

To view project properties, click File > Project Properties....

![Project Properties dialog box](image-url)
Preferences

CyberLink PowerDirector offers a range of choices to set your video production environment to better suit the way you work.

File Preferences

To set your file preferences, click **Edit > Preferences**... The Preferences dialog box opens, displaying the File tab. Available options are as follows:

- **Import directory**: Set the folder where PowerDirector looks by default for media clips when you load media files. To change this folder, click **Browse** and select a new folder.
- **Export directory**: Set the folder where PowerDirector saves captured media files by default. To change this folder, click **Browse** and select a new folder.
- **Captured video prefix**: Enter a default name for captured video files. PowerDirector automatically appends a sequential number to this name to create a unique filename for each captured file. **Always prompt me to confirm filename**: Check this option if you would like PowerDirector to prompt you to enter a filename each time you take a snapshot.
- **Production file prefix**: Enter a default name for files produced in PowerDirector.
- **Snapshot filename**: Enter a default name for snapshot captures. PowerDirector automatically appends a sequential number to this name to create a unique filename for each captured file. Select a file format from the drop-down list. **Always prompt me to confirm filename**: Check this option if you would like PowerDirector to prompt you to enter a filename each time you take a snapshot.
- **Snapshot destination**: Select a destination for snapshot captures from the drop-down list.
• **Number of recently used file projects**: Enter a number (between 0 and 20) of recently used files that you would like to make available in the File menu when you open PowerDirector.

• **Automatically load the most recent project when PowerDirector opens**: Check this option to load the project you have been working on most recently whenever you open PowerDirector.

**General Preferences**

To set your general preferences, click **Edit > Preferences...** The Preferences dialog box opens. Click the General tab. Available options are as follows:

• **Maximum undo levels**: Enter a number (between 0 and 100) of levels of undo you would like to make available while you work on your movie production. Setting a higher number of undo consumes more CPU resources.

• **TV format**: Select the TV format (NTSC or PAL) of the region in which you would like to produce your movie. This format should correspond to the format of the region in which you plan to play your movie (if you burn it to disc).

• **Enable animated Interface**: Check to enable the animated interface in your program.

• **Allow program to append information into files as RichVideo information**: Check to allow PowerDirector to append RichVideo information into the media files.

• **Enable RichVideo information in open media dialog**: Check to allow RichVideo information to be displayed in open media dialog.

• **Automatically connect to the Internet to check for new software updates**: Check to automatically connect to the Internet to check for new software updates for PowerDirector.
Editing Preferences

- **Default workspace**: Select to open the Timeline or Storyboard workspace in PowerDirector by default.
- **Link objects across tracks when moving/deleting content in Video track**: links title, effect, music, and PiP clips to clips in the Video track. Checking this option moves these other clips when a clip in the Video track moves. Uncheck this option to treat Timeline tracks separately and does not bind other tracks to the Video track.
- **Add transition between photos when applying Magic Motion**: Adds a transition effect between adjacent photos when you use the Magic Motion tool.
- **Durations**: Set default durations (in seconds) for image files and the different effects in the timeline.

Confirmation Preferences

- **Always prompt me when TV format conflicts**: Check this option to enable a warning message when you add a video clip to the workspace whose TV format (NTSC/PAL) conflicts with that of the video clips already located in the workspace.
- **Enable file deletion from hard drive and ask me for confirmation**: Check this option if you would like to be able to delete files located on your hard drive using a menu option in the Library.
- **Enable warning when chapters are removed during editing**: Displays a warning message that chapter points have been deleted during video editing.
- **Always prompt me when widescreen is not supported**: Check this option if you would like PowerDirector to prompt you when widescreen format is not supported.
Produce Preferences

- **Output only selected tracks**: Check this option to output only the selected tracks, the tracks that are not selected will not be produced.
- **Preview during production**: Check to enable the video preview window during production. Uncheck to disable the preview window during production and reduce production time.
Set the Project’s Aspect Ratio

Before you start working on your project, you should set your movie’s aspect ratio. The default aspect ratio is 4:3. If you are viewing your movie on a widescreen TV you may change the aspect ratio to 16:9, provided that the media clips you have are also in widescreen format. To modify the aspect ratio for a clip, see Adjust a Video Clip’s Aspect Ratio on p.93.

To set the aspect ratio for your movie, click Edit > Aspect Ratio > 4:3 or 16:9. The preview window will change according to the aspect ratio you have chosen.

**Note:** It is important that you set the aspect ratio of your movie before you start adding clips to the timeline/storyboard. You can not change the aspect ratio of your project once you started editing clips.
The Library

The Library is the storeroom in which all of the media clips used in your projects are kept. In addition, the Library displays all of the different types of effects that can be applied to media clips. The Library appears as follows:

Which contents the Library displays depends on the edit function button you click. These buttons are shown below:
Each of these buttons opens an editing ‘room’ dedicated to a specific task. By default, the Library opens to the Media Room. However, the Library retains the same buttons and functions in each of these views.

**Media Room**

The Media Room is the storage area for the media that you will use in your video editing project. Which type of media clips appear in the Media Room depends on the selection you make in the Filter drop-down list. For more information, see Import Clips into the Library on p.58 and Add a Clip to the Workspace on p.69.

**Effect Room**

The Effect Room contains all of the special effects that can be applied to video or image clips in the workspace. For more information, see Add a Video Effect on p.71.

**Title Room**

The Title Room contains all of the title effects that can be applied to the workspace. For more information, see Add a Title Effect on p.72.

**Transition Room**

The Transition Room contains all of the transition effects that can be applied between video or image clips in the workspace. For more information, see Add a Transition Effect on p.72.
Audio Mixing Room

The Audio Mixing Room contains audio mixing controls for the different audio tracks in the workspace. For more information, see Mix Audio Levels in the Audio Mixing Room on p.96.

Voice-Over Recording Room

The Voice-Over Recording Room contains controls for recording a narration from a microphone while watching the video clip the voice-over is destined to accompany. For more information, see Record a Voice-Over on p.44.

Chapter Setting Room

The Chapter Setting Room contains options for automatically or manually setting chapter markers. Setting chapters on your final disc allows viewers to jump from the menu page to the chapter markers you have set in order to navigate around your disc. For more information, see Set Chapters on p.76.
Managing Media in the Library

After you have obtained the media files you want to work with, the next step is to add them into the Library (where they become media “clips”) in order to make them available for your movie. Once your clips are loaded, you can change the display of your media clips in the Library and delete unnecessary clips.

Import Clips into the Library

When importing media clips into PowerDirector’s Library, you have two options: to import media files individually, or to import an entire folder that contains media files you want to use in your current project.

Note: PowerDirector’s file format support varies, depending on version. For information on the availability of specific features in the PowerDirector version that you are using, please check the Readme file.

Import Individual Media Files

To specify individual media files to import into the Library, do this:

1. Click to open the Media Room.
2. Select the type of media you want to import (or All Media) from the Filter drop-down list.

Note: By selecting a media type (other than All Media) in this drop-down list, you restrict the type of media displayed in the Library, and consequently, the type of media that you can import.

3. Click and select Import Media File(s). A dialog box opens.
4. Locate and open the file(s) you want to add. Thumbnails of each of the media files you have selected appear in the Library.
Import a Media Folder

To import all of the media files in a particular folder, do this:

1. Click to open the Media Room.
2. Click and select Import a Media Folder. A dialog box opens.
3. Locate the folder you want to open, then click OK. All of the media files in that folder are loaded into the Library.

Sort Clips in the Library

Once your media clips are loaded into the Library, you can restrict the display to a certain type of media for a simpler view, and you can also sort media files using different criteria.

- Select the type of media you want to view (or All Media) from the Filter drop-down list. Only those clips that belong to the media type you have selected are displayed in the Media Room.

- To change the way media files are sorted, click . Select Sort by, then choose a sorting option (Name, Duration, File size, Date, Type).

Note: Color boards can be sorted by Name, R (Red), G (Green), and B (Blue), or Date.

- To change the way media files are displayed, click . Select Display by, then choose a display option (Thumbnails or Details).
Remove a Clip from the Library

To remove a media clip from the Library, do this:

1. Click to open the Media Room.
2. Select the clip(s) you want to remove, then do one of the following:
   - Press the Delete key.
   - Click and select Delete selected.
   - Right-click the clip(s), then select Remove from Library or Delete from disk.

Note: The Remove from Library option makes the clip unavailable in the Library but does not affect the original media file on your hard disk. The Delete from Disk option both removes the clip from the Library and deletes the original file on your hard disk.
Rename a Clip in the Library

Clips you import into the Library retain their original file names, which are often non-descriptive and difficult to use in a video editing project. By using an alias, you can rename any clip in the Library to better suit your project. (For example, you may wish to use the alias “first video clip” instead of “video_005.mpg.”)

To rename a clip using an alias, do this:

1. Right-click the clip you want to rename and select **Use Alias**.
2. Enter a name and press Enter on your keyboard or click outside the name box. The clip appears in the Library using the alias.

Restore a Clip’s Original File Name

Although using an alias is handy while working on your video project, you may find it necessary to view the original name of the clip (for example to verify which version of a clip you are using).

To restore a clip’s original name, right-click the clip you want to rename and select **Restore to Original Clip Name**. The clip now appears in the Library using the original clip name.
View Clip Properties

If you need to view information about a media clip in the Library or the workspace (such as its format, file path, size, frame rate, etc.), you can view the clip’s properties.

To view clip properties, right-click the clip and select Properties. The Properties dialog box opens.

![Properties dialog box](image)
Detect Scenes in a Video Clip

The scene detection function automatically creates individual clips based on the individual scenes contained within a video clip. Detected scenes are not split from the original clip, but can be added to the workspace like any other media clip. Likewise, they may also be merged together or removed entirely without changing the original video clip.

To detect scenes in a video clip in the Library, do this:

1. Select the video clip whose scenes you want to detect.
2. Click . The Scene Detection window opens.
3. Increase or decrease scene detection sensitivity, if necessary. Increased or decreased scene detection sensitivity yields an increased or decreased number of scenes that are detected. You may do this in one of the following ways:
   - Drag the Sensitivity slider.
   - Click the or buttons.
4. Click Settings and set your scene detection options, if necessary:
   - The Detection Method section pertains to video clips that have been captured. (If the video clip was not captured, the Detection Method options are disabled.) If you have a DV
AVI clip that contains multiple time codes (i.e.: time codes are automatically set when you start and stop recording) and you wish to split up your clip in this manner, select **Detect by changing of timecodes**. Otherwise, use **Detect by changing of video frames**.

5. Locate the position at which you would like to begin detecting scenes. You may do this in one of the following ways:
   - Use the playback buttons.
   - Drag the time slider.
   - Enter a timecode.

6. Click **Detect**. The video clip plays in the Preview Window from the point you have set.
   - To set scenes manually, click **Split** instead of **Detect**.
   - To stop the scene detection process before completion, click **Stop** or press the <Esc> key.
   - After the original scene detection, you may further detect scenes within a newly generated scene. To detect scenes manually (including changing detection sensitivity), select a scene, then repeat the steps for detecting scenes. To detect scenes automatically, right-click a scene and select **Detect again from this scene**.
   - To remove a scene after detection, right-click the scene and select **Remove scene**.

7. Click **OK** to close the Scene Detection window.
   - To return to the Library, click **Up One Level**.

Clips created by the new scenes are displayed in a subfolder under the original video clip. They can be added to the workspace and managed in the Library like any other video clip.

Video clips that contain detected scenes show a small folder icon in the lower right-hand corner of the clip when displayed in the Library. To display a clip’s scenes, click the folder icon.
Managing Clips in the Workspace

The edit interface consists of a workspace to which you can add clips. You can set which view opens by default in the Preferences dialog box. You can also switch views by clicking the Timeline or Storyboard buttons. You can load media and effect clips into specific tracks in the workspace, move them to different locations in your story, and delete them from the workspace. This section describes how to add clips to the proper track and how to manage clips once they have been added.

Timeline View

When you first open PowerDirector, the program opens to the Edit interface in whichever mode you have set in your preferences.

To switch to Timeline view, click .
Media Tracks

The Timeline contains the following tracks:

<table>
<thead>
<tr>
<th>Track</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Video" /></td>
<td>Contains your movie’s main video and/or image clips.</td>
</tr>
<tr>
<td><img src="image" alt="Effect" /></td>
<td>Contains special effects that apply to the video or image clip in the Video track at the same location.</td>
</tr>
<tr>
<td><img src="image" alt="Overlay" /></td>
<td>Contains video/image clips, which are overlaid on any clip in the Video track that appears during the PiP effect’s duration.</td>
</tr>
<tr>
<td><img src="image" alt="Title" /></td>
<td>Contains title effects that appear over any clips in the Video track that occur during the title effect’s duration.</td>
</tr>
<tr>
<td><img src="image" alt="Audio" /></td>
<td>Contains a narrative voice-over or second audio clip.</td>
</tr>
<tr>
<td><img src="image" alt="Music" /></td>
<td>Contains your movie’s main audio clip.</td>
</tr>
</tbody>
</table>

Locking/Unlocking Tracks in the Timeline

To lock a track in the Timeline, click ![lock](image) at the left of the track. When a track is locked, you cannot add new clips to the track, nor move or edit the clips it contains. To unlock a track in the Timeline, click ![unlock](image) at the extreme left of the track. When a track is unlocked, you can freely add, move, and edit clips. For more information, see Move a Clip in the Workspace on p.73.

Showing/Hiding Tracks in the Timeline

To hide a track in the Timeline, first click ![Movie](image) in the Preview window, then click ![hidetrack](image) at the extreme left of the track. When a track is hidden, it will not be displayed in the Preview window. This way you can preview your project by tracks and concentrate on the track...
you are working on. To display a track that has been hidden in the Timeline, first click \[Movie\] in the Preview window, then click \[\] at the extreme left of the track. For more information, see Preview Your Movie in the Preview Window on p.79.

Resizing the Ruler

You can resize the ruler for a more expanded or more condensed view of your production. To resize the ruler, click inside the ruler and drag. Expand the ruler for more a precise view, which is especially handy when aligning clips and effects, or condense the ruler for a global overview of your entire production.
**Storyboard View**

You can switch to Storyboard view while editing your movie for a simpler view of the clips that your movie contains.

To switch to storyboard view, click 📌. 

![Storyboard View](image)
Add a Clip to the Workspace

The different types of clips may only be added to specific tracks. The sections below describe the procedures for adding each kind of media clip into the workspace.

Note: You may prefer to add clips in Storyboard view, since this view is simpler than the Timeline view. However, clips can only be added to the Video track in this view. Therefore, this section uses the Timeline view in all of the procedures.

Add Video & Image Clips

You can add video and image clips to either the Video track or the PiP (picture-in-picture) track. To create the basic framework of your movie, add video and image clips to the Video track. Add clips to the PiP track only to create a picture-in-picture effect.

To add video or image clips to the workspace, do this:

1. Click 📀 to open the Media Room.
2. Select **Video**, **Image**, or **All Media** from the Filter drop-down list to sort the clips in the Media Room.
3. Select a clip, then add it to the workspace. You may do this in one of the following ways:
   - Click 📀 to add the clip to the Video track or 📀 to add the clip to the PiP track.
   - Drag clips to a desired position in the Video or PiP track. When adding clips to the Video track, you cannot leave an empty gap between the last clip and the new clips you are adding. Clips added to the end of the Video track follow immediately after the final clip in that track.

Note: You may select several clips and drag them together into the same track, provided all of the clips are compatible with the destination track.
Add Color Boards

Using color boards allows you to insert solid frames of color into your movie. You might, for example, want to fade in to or out from a certain color, or add a solid background to a picture-in-picture effect.

Color boards are not media files as such, but they can be applied to the workspace and managed in the Library just like video and image clips. You can add color boards to either the Video or the PiP track.

To add a color board to the workspace, do this:

1. Click to open the Media Room.
2. Select Color boards from the Filter drop-down list. The current color boards appear in the Library.
3. Select a color board, then add it to the workspace. You may do this in one of the following ways:
   - Click to add the color board to the Video track or to add the color board to the PiP track.
   - Drag one or more color boards to a desired position in the Video or PiP track. When adding clips to the Video track, you cannot leave an empty gap between the last clip and the new clips you are adding. Clips added to the end of the Video track follow immediately after the final clip in that track.
Add Audio Clips

Using audio clips allows you to add background music or a narrative voice-over to your movie. PowerDirector provides two tracks for audio media (the Music and Voice tracks), which you can use interchangeably.

**Note:** Audio files can only be added to the workspace in Timeline view. If you drag an audio file to the workspace in Storyboard view, the workspace automatically switches to Timeline view.

To add an audio clip to the workspace, do this:

1. Click to open the Media Room.
2. Select **Audio** or **All Media** from the Filter drop-down list.
3. Select an audio clip, then add it to the workspace. You may do this in one of the following ways:
   - Click to add the audio clip to the Voice track or to add the audio clip to the Music track.
   - Drag one or more audio clips to a desired position in the Voice or Music track. Audio clips can be added at any point in this track.

Add a Video Effect

The procedure below describes how to add a video effect to the Timeline.

To add a video effect to the Timeline, do this:

1. Click the button to open the Effects Room.
2. Drag an effect from the Effects Room into the Effect track directly beneath the clip(s) in the Video track that you want to affect.
   - You may click to add the effect to the Effect track at the current position of the Timeline slider.
• You can randomly add an effect at the current position of the Timeline slider. Click ☞, then select the random option.

Add a Title Effect
The procedure below describes how to add a title effect to the Timeline.

To add a title effect to the Timeline, do this:

1. Click ☞ to open the Title Room.
2. Drag an effect from the Title Room into the desired position in the Title track.
   • When a title effect is selected, you may click the button located below the Library to add the effect to the Title track at the current position of the Timeline slider.
   • You can randomly add an effect at the current position of the Timeline slider. Click ☞, then select the random option.
3. Edit the title effect in the Title Designer that opens. See Modify a Title Effect on p.124.

Add a Transition Effect
The procedure below describes how to add a transition effect to the Timeline.

To add a transition effect to the Timeline, do this:

1. Click ☞ to open the Title Room.
2. Drag an effect from the Transition Room between the clip(s) in the Video track that you want to affect.
   • You can randomly add an effect at the current position of the Timeline slider. Click ☞, then select the random option.
   Transition effects are randomly applied between all of the clips currently in the Timeline.
Move a Clip in the Workspace

Once a clip has been added to the workspace, you can drag it to a different location on the track it is currently located in. (Only audio clips can be dragged between tracks.) You may find moving media clips easier in Storyboard view, especially if the clip has an extremely short duration, or if you need to move it a relatively long distance over the workspace.

Note: Moving a clip in the Video track automatically adjusts the duration of the effects applied to it to synchronize with the remaining clips in the Video track. Some effects may therefore disappear or change length when you move a clip.

Select Clips in the Workspace

To select clips in the workspace, do one of the following:

- To select clips in a series, press the Shift key, then select the clips.
- To select multiple, non-contiguous clips, press the Ctrl key, then select the clips.
- To select all of the clips in a track, right-click inside the track, then select Select All.

Cut/Copy/Paste a Clip in the Workspace

You can cut, copy, and paste media clips in PowerDirector’s workspace.

When you paste, clips appear at the current position of the Timeline slider. If that position occurs within the duration of a media clip, the new clip is pasted immediately after that clip. If the Timeline slider is positioned in a gap between clips, the new clip is pasted and truncated (if necessary) to fit in the gap (PiP/Music/Voice tracks only). If the Timeline slider is positioned after the last clip, the new clip is pasted immediately after the last clip.
Align Clips in the Timeline

You can align PiP, effect, and title clips to the edge of the clip above them in the Video track to ensure that their starting and ending times coincide.

To align a clip, right-click it in the timeline, then select Align to Edge. The Align to Edge dialog box opens.

The Align Left tab displays options for stretching the clip’s left edge. The following options are available:

- **Extend to the left edge**: Extends the clip to the next available border to the left in the Video track.
- **Shrink to the right edge**: Shrinks the clip to the next available border to the right in the Video track.

The Align Right tab displays options for stretching the clip’s right edge. The following options are available:

- **Extend to the right edge**: Extends the clip to the next available border to the right in the Video track.
- **Shrink to the left edge**: Shrinks the clip to the next available border to the left in the Video track.
Remove a Clip from the Workspace

To remove a clip from the workspace, select the clip(s) you want to remove, then do one of the following:

- Press the Delete key.
- Click the Delete button.
- Right-click the clip, then select Delete.

Replace an Effect in the Timeline

You can replace any effect in the Timeline with a different effect that you select in the Effect Room without having to delete one effect and add another.

To replace an effect in the Timeline, do this:

1. Position the Timeline slider on the effect that you want to replace.
2. Click 📻 to open the Effect Room.
3. Right-click a new effect in the Effect Room, then select Add/Replace in Timeline. The new effect replaces the effect in the Timeline.
Set Chapters

Chapters allow for ease of navigation on a disc. If you set chapters on your disc, viewers can jump from the menu page to the start of these chapters in order to skip previous content. However, you may choose not to include chapters. If you do not set chapters, your movie plays automatically when the disc is inserted into a player.

To set chapters automatically, do this:

1. Click \(\text{Chapter Setting Room}\) to open the Chapter Setting Room in the Library.

2. Set chapter points by doing one of the following:
   - To set a chapter at the beginning of each video clip, click \(\text{Set a chapter at the beginning of each video clip}\).
   - To set chapters at fixed intervals, enter an interval (in minutes), then click \(\text{Set chapters at fixed intervals}\).
   - To specify the number of chapters in your disc, enter the number of chapters in the entry box, then click \(\text{Set chapters evenly}\).
   - To set chapter points manually, navigate to a location on the timeline, then click \(\text{Set chapter points manually}\).
   - Click \(\text{Remove chapter point}\) to remove a chapter point.
• Click to remove all of the chapter points you have set.

You can customize the thumbnail image for your chapter menu button. To set a chapter thumbnail, do this:

1. Select the chapter whose thumbnail you want to change.
2. Drag the timeline slider and navigate to the location of the new thumbnail image in the timeline. (Use the Preview window to preview your thumbnail image.)
3. Click to set the chapter thumbnail to the new image.
Viewing SVRT Information

SVRT (Smart Video Rendering Technology) is a proprietary rendering technology from CyberLink that recognizes which portions of a movie clip have been modified (and therefore require rendering during production), and which portions of a movie clip have not been changed (and thus can be skipped over during rendering). By viewing SVRT information, you can simulate the production process.

Note: For more information on SVRT, see SVRT2: When Can I Use it? on p.209.

To view how PowerDirector uses SVRT in your current project, do this:

1. Click View > SVRT Information. The SVRT Info Room opens and the SVRT track appears on the timeline.

2. Select the profile you want to use to produce your movie, then click Update SVRT Info to view updated SVRT information. The colors that appear in the SVRT track designate how PowerDirector uses SVRT for the related clip (or clip portion).
   - **Green**: no rendering is required during production. (This requires the least amount of production time.)
   - **Blue**: only video rendering is required.
   - **Yellow**: only audio rendering is required.
   - **Red**: both audio and video rendering is required. (This requires the greatest amount of production time.)
Preview Your Movie

Before you commit your movie to disc, it’s a good idea to preview it to make sure all of your clips and effects are working to create the movie you want. It is highly recommended that you preview your movie at least once before production so you can solve problems without spending time unnecessarily in production.

Preview Your Movie in the Preview Window

You can preview your movie at any point during the editing process in order to ensure that your editing is going smoothly. Using the Timeline slider, you can preview your movie production from any point within the Timeline.

Note: When previewing clips in the workspace, ensure that the preview window is in Movie mode. If the preview is in Clip mode, click the Movie button before previewing your movie production.

1. Click the Movie button in the preview window.
2. Locate the point at which you want to begin your preview. You may do this in one of the following ways:
   - Drag the Timeline slider.
   - Drag the preview window slider.
   - Enter a timecode in the timecode box.
3. Press Play. The preview starts from the point you have specified.
4. Use the playback buttons to control the preview.
Preview Your Movie in the Media Viewer

To preview your movie in the Media Viewer, do this:

1. Click the Movie button in the preview window.

2. Click " and select Instant Preview with Media Viewer. The Media Viewer opens.

   • You may drag an edge or a corner to resize the Media Viewer window.
   • You may preview your movie in different resolutions: High (640x480), Normal (320x240), or Low (160x120). Click " and select the resolution you want.
   • You can preview a rendered version of your movie. The rendered version will be closer to your finished production in quality, however it will take longer to generate the preview.

   Click " and select Rendering Preview with Media Viewer to view the rendered version.

3. Press " . The preview starts.

4. Use the playback buttons to control the preview.
Chapter 4:

Editing Clips

This chapter discusses how to load media into the Library for use in your projects, how to add your media clips to the workspace, then how to manipulate and edit media clips once they are loaded into the workspace. Adding and manipulating media clips allows you to construct the framework of your movie production - to lay out and organize the story you want to tell.

This chapter contains the following sections:

- Editing Media Clips on p.82
- Using Magic Tools on p.98
- Modifying Effects on p.110
- Preview a Clip on p.136
Editing Media Clips

‘Editing’ is a broad term that encompasses a number of different functions: you can, for example, trim unwanted sections from video or audio clips, increase or decrease the speed of a video clip, or apply a special effect. This section describes all of the editing processes that you can perform on the different types of media clips.

Note: The functions in this section can only be performed in Timeline view.

Split a Clip

You can split a media clip into two clips at the current position of the Timeline slider. The procedure is the same for any type of clip (media or effect) except for transitions.

To split a media clip, do this:
1. Select the clip you want to modify.
2. Place your cursor at the position at which you want to split the clip.
3. Click Split. The clip is split into two independent clips that can be moved or modified separately in the workspace.

Note: Splitting a video or audio clip does not delete any portion of the content. Both halves of a split video or audio clip can be stretched back to any length up to the original duration.
Trim a Video or Audio Clip

Video clips captured from external capture devices often contain unwanted portions at the beginning, between scenes, or at the end. These unwanted portions can easily be removed in PowerDirector using the Trim function.

Likewise, if you want to tailor your audio clip to fit the duration of a video clip, you can easily trim your audio clip to a desired length.

**Note:** Trimming a video or audio clip does not delete any portion of the content.

Perform a Simple Trim

To trim a video or audio clip, do this:

1. Select the clip you want to modify.
2. Click **Trim**. The Trim option panel opens.
3. Enter a mark in and mark out time. You may do this in one of the following ways:
   - Click inside the timecode box and enter a time using your keyboard.
   - Drag the mark in/mark out sliders to the correct time position.
   - Navigate to the desired time position using the playback buttons.
4. Click the Mark in and Mark out buttons.
Perform a Multiple Trim

You can trim multiple portions from a video clip, resulting in individual clips, which are independent of the original clip. You can also detect scenes using the Multi Trim tool. Detected scenes, by contrast, are not split from the original clip, but are simply divisions contained within it.

To perform a multiple trim on a video clip, do this:

1. Select the clip you want to modify.
2. Click **Multi Trim**. The Multi Trim dialog box opens.
3. Navigate to the mark in time by doing one of the following:
   - Click inside the timecode box, enter a time using your keyboard, then press the **Enter** key.
   - Drag the time slider to the correct time position.
   - Use the playback buttons.
4. Click **to set the mark in point.**
• To view the timeline more clearly, click 🔬 to open the timeline magnifier. Click ➕ to zoom in or ➖ to zoom out.

5. Navigate to the mark out time, then click 🎥 to set the mark out point. The scene you set appears in the pane to the right of the preview window.

• To detect scenes automatically, click 📋. For more information, see Detect Scenes in a Video Clip on p.63.
• To remove a scene, click Remove.
• To split a long scene into two shorter scenes, navigate to a position inside a chapter you have already set, then click 💼 to split the scene.

Note: You can continue to cut multiple scenes from the video clip. Each scene, however, must have a duration of at least two frames.

6. Click OK.

Trim by Dragging an Edge

You can trim any kind of media clip in the Timeline (including audio, video, and image clips and color boards) by dragging either edge of that clip. You may find trimming a clip in this way easier if you first expand the ruler.

Note: Video and audio clips cannot be lengthened beyond their original duration.

To trim a media clip by dragging an edge, do this:

1. Select the clip you want to modify.
2. Position your cursor at one end of the clip and drag the end of the clip to the new position.

**Note:** You can drag the edge of a clip to lengthen it or to shorten it. If you compress the start of a video or audio clip, playback begins at a later frame within the clip. If you compress the ending, playback ends at an earlier frame within the clip.
Trim a Video Clip Using Precise Cut

If you need to trim video extremely accurately (for example at the frame level), use the Precise Cut feature in the Media Editor window. The Media Editor is a large, resizable preview window that offers a magnified timeline that is particularly useful for accurate trimming of longer videos.

To trim a video clip using Precise Cut in the Media Editor, do this:

1. Select the clip you want to modify.
2. Click Trim.
   - Click Clip on the preview window, if necessary.
3. Click 📀 and select Instant Preview with Media Viewer. The Media Editor window opens.

![Media Editor Window](image)

4. Click🔍 to enable the Precise Cut magnifier, then click➕ to zoom the timeline in or➖ to zoom out.
5. Enter a mark in and mark out time. You may do this in one of the following ways:
   - Click inside the timecode box and enter a time using your keyboard.
   - Drag the mark in/mark out sliders to the correct time position.
   - Use the playback buttons.

**Note:** Drag the bottom slider for more precise control.

6. Click the Mark in and Mark out buttons.
7. Click \( \times \) to close the Media Editor window.

**Mute an Entire Media Clip**

You may wish to mute the audio output of an entire media clip. To do this, right-click the clip and check Mute Clip. Any audio volume keys you have added are hidden.

To unmute the track, right-click the track and uncheck Mute Clip. The audio volume keys you have added are restored.

**Mute an Entire Track**

You may wish to mute the audio output of an entire track. To do this, right-click the track and select Mute Track. Any audio volume keys you have added are hidden.

To unmute the track, right-click the track and deselect Mute Track. The audio volume keys you have added are restored.

**Take a Still Snapshot of a Video Clip**

You can capture a single frame from a video clip and automatically load the snapshot in the Library.

To take a snapshot of a video clip, do this:

1. Select the clip you want to modify.
2. Click Trim.
3. Navigate to the frame you want to capture using the playback buttons.
4. Click Snapshot. The frame is captured and stored in the Library as an image file.
Change the Speed of a Video Clip

Slow-motion or fast-motion effects can grab your audience’s attention as well as break up the rhythm of a movie.

**Note:** Video clips can be located in either the Video or PiP track.

To change the speed of a video clip, do this:

1. Select the clip you want to modify.
2. Click **Speed**. The speed option panel opens.

3. Set the new speed (between .5x and 2x). You may do this in one of two ways:
   - Drag the slider to increase or decrease the speed.
   - Enter a timecode in the New video length box. (This method allows more accurate control, as you can specify a length down to the frame level.)

4. Click **x** to close the option panel.
Stretch the Audio Portion of a Video Clip

When you alter the speed of a video clip, you may wish to stretch the audio portion at the same proportion as the video portion.

To change the speed of a video clip, do this:

1. Select the clip you want to modify.
2. Click Speed. The speed option panel opens.
3. Click Stretch Audio. This option stretches the video clip’s audio portion (between .5x and 2x). The pitch of the audio portion remains unchanged to avoid unexpected audio results.
4. Click to close the option panel.

Change the Color of a Visual Media Clip

You may wish to change the color attributes of a video or image clip or a color board in order to produce a surprising effect, or simply to emulate reality more closely. Either result is easy to achieve in PowerDirector.

To change the color of a visual media clip, do this:

1. Select the clip you want to modify.
2. Click Color. The color option panel opens.
3. Set the color options that you want to apply:
   - **Brightness**: the brightness/darkness of the image
   - **Contrast**: the difference in proportion between lights and darks in the image
   - **Hue**: the individual colors in the image
   - **Saturation**: the depth of the colors in the image
• **Sharpness**: the clarity of details in the image

4. Click ✗ to close the option panel.

**Edit an Image Clip in PhotoNow!**

To edit an image in the CyberLink PhotoNow! program, select an image clip, then click the **PhotoNow!** button. PhotoNow! is the quickest way to touch-up your photos. You can resize, crop, rotate, remove red eye, adjust the color and brightness, and more. For more information on using the CyberLink PhotoNow! program, see that program’s online help.
Set a Video Clip’s Interlacing Format

All video clips have an interlacing (TV) format, which specifies how frames are displayed. Using video clips with conflicting (or incorrect) TV formats can result in degraded video quality in your final production.

Before you produce your movie, set all of the video clips to the same format. While PowerDirector can normally detect and suggest the correct format, some interlaced video (such as a video with very little motion) may be misjudged as a progressive video. PowerDirector automatically produces interlaced video for DVD, SVCD, and DV-AVI. Only change this setting if you are sure that PowerDirector has wrongly set the format.

Note: This is an extremely important step to take before production, as it can drastically affect final video quality!

To set a video clip’s TV format, do this:

1. Right-click the video clip whose interlacing format you want to set and select Set TV format. The Interlace and Progressive Settings dialog box opens.

2. Select an interlacing option:
   - If you know the interlacing format you want to use, select the corresponding option
   - If you do not know the interlacing formation you want to use, select Scan and Suggest Format. PowerDirector scans the clip and automatically selects the best format.

3. Click OK.
Adjust a Video Clip’s Aspect Ratio

All video clips usually come in two aspect ratios, 4:3 and 16:9. Depending on your media clips and the medium you will be using to view your movie, you can adjust your movie’s aspect ratio accordingly. Before you produce your movie, set the aspect ratio for all of the video clips so that it matches the aspect ratio of your project.

Depending on the aspect ratio of your project and the aspect ratio of your clips, you have two options available.

If your project aspect ratio is 4:3 and you wish to produce movies with clips of 16:9 aspect ratio, do this:

1. Right-click the video clip whose aspect ratio you want to adjust and select Set Aspect Ratio. The Clip Aspect Ratio Settings dialog box opens.

2. Select an aspect ratio option:
   - If you know that the aspect ratio of your clip is 16:9, select the option The aspect ratio of the select video is 16:9 and choose an option from the dropdown list.
   - If you know that the aspect ratio of your clip is neither 4:3 or 16:9, select the option Neither 4:3 nor 16:9 and choose an option from the dropdown list.
   - If you do not know the aspect ratio of your clip, select Detect and Suggest. PowerDirector scans the clip and automatically selects the best option.

3. Click OK.
If your project aspect ratio is 16:9 and you wish to produce movies with clips of 4:3 aspect ratio, do this:

1. Right-click the video clip whose aspect ratio you want to adjust and select Set Aspect Ratio. The Clip Aspect Ratio Settings dialog box opens.

2. Select an aspect ratio option:
   - If you know that the aspect ratio of your clip is 4:3, select the option **The aspect ratio of the select video is 4:3** and choose an option from the dropdown list.
   - If you know that the aspect ratio of your clip is neither 4:3 or 16:9, select the option **Neither 4:3 nor 16:9** and choose an option from the dropdown list.
   - If you do not know the aspect ratio of your clip, select **Detect and Suggest**. PowerDirector scans the clip and automatically selects the best option.

3. Click **OK**.
Change Audio Clip Volume Levels

Your movie may contain audio portions in the Music track, the Voice track, as well as in the video clips you have added. Since all of these tracks have probably been recorded at different levels, the result of so many audio sources can produce an overwhelming and confusing sound track. However, the audio levels of all of these different tracks can be mixed to produce a more harmonious sound track to your movie. Audio levels can be mixed in the Audio Mixing Room or inside the audio clips in the Music and Voice tracks.

In-Track Audio Mixing

You can change the level of volume at any point within an audio clip in the Timeline.

To change the volume level of an audio track in the Timeline, do this:

1. Select the clip you want to modify.
2. Click on the audio level line at the point where you want to change the audio level to set a volume key. Drag the volume key up to increase the volume or down to decrease the volume.

   • Set levels at fewer volume keys along the track for subtler changes in volume, or more volume keys for more extreme changes in volume.
   • To remove a volume key, drag it outside the clip’s borders.
Mix Audio Levels in the Audio Mixing Room

Using the Audio Mixer in the Audio Mixing Room gives you very precise control over the volume levels of the audio clips in the workspace. The Audio Mixer contains audio mixing controls for the different audio tracks in the workspace. The Audio Mixing Room appears as follows:

To mix audio in the Audio Mixing Room, do this:

1. Click 🎧. The Audio Mixing Room opens.
2. Click Play.
3. Use the sliders to mix the volume levels of the corresponding tracks.
   - Use the vertical sliders to set volume keys to increase or decrease the volume of the track on the fly.
   - Use the horizontal sliders to increase or decrease the volume of the entire track.
4. Click ✗ to close the Audio Mixing Room.
Add a Fade Effect to an Audio Clip

To add a fade-in/fade-out effect to an audio clip, do this:

1. Click 🎧. The Audio Mixing Room opens.
2. Click the button corresponding to the type of fade effect you want:
   - Click 🎧 to add a fade-in effect.
   - Click 🎧 to add a fade-out effect.
3. Click ❌ to close the Audio Mixing Room.

Restore an Audio Clip’s Volume Levels

If you are dissatisfied with the volume level of any audio clip after manually setting volume keys, you can easily restore the clip’s original volume level. To do this, right-click the track and select Restore Original Volume Level. Any audio volume keys you have added are permanently removed.
Using Magic Tools

PowerDirector’s Magic Tools make working with audio, video, and image clips easier than ever before. PowerDirector offers the following Magic Tools:

- **Magic Clean**: Cleans audio, video, and image clips.
- **Magic Motion**: Zooms and pans image clips.
- **Magic Cut**: Automatically condenses long video segments into shorter clips that contain only the best moments.
- **Magic Fix**: Fixes shaking videos, remove red-eyes and enhance the focus on photos.
- **Magic Style**: creates professional movies with pre-designed style templates automatically.
- **Magic Music**: Adds background music that automatically adjusts to suit different durations.

When you open a magic tool, two buttons are available for viewing the clip. These buttons switch the view in the Preview window to allow you to compare the clip before and after modification. Descriptions of the buttons are below:

- **Original**: Displays the clip as it appears before the current effect is applied.
- **Output**: Displays the clip with the current modification applied.
Magic Clean

PowerDirector’s Magic Clean tool can be used to clean up image files, video files, as well as audio files. The Magic Clean tool can help revitalize your project by making your media clips cleaner, sharper, and brighter and your audio files crisper and clearer.

Perform Magic Clean on an Image Clip

When applied to image clips, PowerDirector’s Magic Clean tool enhances the image for a sharper, brighter picture. This tool is ideal for use with photos taken when lighting is either insufficient or too intense.

To perform Magic Clean on an image clip, select the clip in the timeline, then click 📷. The Magic Clean dialog box opens.

The following options are available:

- **Apply Magic Clean**: Check this option to enable Magic Clean for photo.

- **CyberLink EagleVision**: Adjusts the brightness/contrast/saturation ratios so that you do not need to change the color settings if the clip contains portions that are overly dark or bright.

- **White Balance**: Adjust the color temperature to correct the white balance result or to create specific atmosphere such as winter or summer. A warmer color temperature shifts light toward the red; a colder color temperature shifts light toward the blue.
• **Compare qualities in split preview:** This option is only available with White Balance. Check this option to compare your changes in a split preview.

• **Apply to all photo clips:** Check this option to apply your changes to all the photo clips in the project.

**Perform Magic Clean on a Video Clip**

When applied to video clips, PowerDirector’s Magic Clean tool automatically adjusts the video output for a sharper, brighter picture. This tool is ideal for use with video recorded when lighting is either insufficient or too intense. There are also noise reduction options that can be applied to the audio portion of a video clip.

To perform Magic Clean on a video clip, select the clip in the timeline, then click 🎥. The Magic Clean dialog box opens.

![Magic Clean dialog box]

The following options are available under the **Clean Video** Tab:

• **Apply Magic Clean:** Check this option to enable Magic Clean for video.

• **CyberLink EagleVision:** Adjusts the brightness/contrast/saturation ratios so that you do not need to change the color settings if the clip contains portions that are overly dark or bright.

• **White Balance:** Adjust the color temperature to correct the white balance result or to create specific atmosphere such as winter or summer. A warmer color temperature shifts light toward the red; a colder color temperature shifts light toward the blue.
• **Compare video qualities in split preview**: Check this option to compare your changes in a split preview.

• **Apply to all clips**: Check this option to apply your changes to all the video clips in the project.

The following options are available under the **Clean Audio** Tab:

• **Apply CyberLink Noise Reduction to remove audio noise**: Check this option to enable Magic Clean for audio.

• **Noise Type**: Filters out noise from the audio track. Drag the slider to remove more or less noise.
  - **Machinery noise**: Applies a specific noise reduction technology to reduce background noise created by recording outside.
  - **Wind noise**: Applies a specific noise reduction technology to filter out wind noise.
  - **Clicking noise**: Applies a specific noise reduction technology to filter out clicking noise.

• **Apply to all clips**: Check this option to apply your changes to all the video clips in the project.
Perform Magic Clean on an Audio Clip

The Magic Clean tool is ideal for use with audio clips that were recorded outdoors, in a room with poor acoustics - even in a car or other noisy location. The Magic Clean tool uses CLNR (CyberLink Noise Reduction) technology to improve output audio.

To perform Magic Clean on an audio clip, select the clip in the timeline, then click \( \text{ } \). The Magic Clean pane opens.

The following options are available:

- **Apply CyberLink Noise Reduction to remove audio noise**: Check this option to enable Magic Clean for audio.
- **Noise Type**: Filters out noise from the audio track. Drag the slider to remove more or less noise.
  - *Machinery noise*: Applies a specific noise reduction technology to reduce background noise created by recording outside.
  - *Wind noise*: Applies a specific noise reduction technology to filter out wind noise.
  - *Clicking noise*: Applies a specific noise reduction technology to filter out clicking noise.
- **Apply to all clips**: Check this option to apply your changes to all the audio clips in the project.
Magic Motion

PowerDirector’s Magic Motion tool zooms or pans an image clip, creating a motion effect in your final movie. The Magic Motion tool is ideal for turning slide shows into engaging presentations - especially when combined with Magic Music.

To perform Magic Motion on an image clip, select the clip in the timeline’s Video track, then click 📸. The Magic Motion pane opens.

The following options are available:

- **Apply Magic Motion to the selected photo**: Check this option to enable Magic Motion for the selected photo.
- **Motion Effect**: Select the motion effect you wish to use. Choose between Random, Zoom, Pan, and Zoom and Pan.
- **Automatically set focus**: Check this option to set the focus on the image automatically. Setting a focus in portrait layout pans across the image. Setting a focus in landscape layout zooms in on the image.
- **Apply to all photo clips**: Check this option to apply the Magic Motion effect to all photos in the Video track. (You can set the transition option in File Preferences. See File Preferences on p.50.)

Once you apply the Magic Motion effect, an icon appears on the clip in the timeline, indicating that Magic Motion has been applied. If you later decide to remove the Magic Motion effect, open the Magic Motion dialog box and uncheck **Apply Magic Motion to the selected photo**.
**Magic Cut**

You can fit a video clip to a specific time by automatically cutting out unnecessary portions and keeping only the best moments. The Magic Cut feature uses “magic” video technology to locate and keep the most interesting moments, while discarding sections of lesser importance. The Magic Cut tool is ideal for condensing long video segments into shorter clips - for example, cutting one hour of video down to ten minutes.

**Note:** If the video segment you are using is shorter than 15 minutes in length, has been previously edited, or contains extremely important moments, you may prefer to edit it manually - for example, by using the Multi Trim function. See Perform a Multiple Trim on p.84.

To perform Magic Cut on a video clip, select the clip in the timeline’s Video track, then click . The Magic Cut dialog box opens.

![Magic Cut dialog box](image)

The following options are available under the **Duration** tab:

- **Auto apply transitions when possible**: Check this option to automatically apply transitions.
- **Fit duration to background music**: Use the total duration of the selected background music files as the new duration for Magic Cut. The new video duration will be exactly as long as the background music.
- **Add**: Add audio file to the background music list.
- **Delete**: Delete the selected audio file from the background music list.
• 🡅: Move the selected audio file up the background music list.

• 🡆: Move the selected audio file down the background music list.

• **New Duration**: Enter the duration you would like to give to the clip (in hours:minutes:seconds:frames).

• **Original Duration**: Indicates the original duration of the video file.

The **Criteria** tab defines the rules used by Magic Cut to determine how to cut a video. The following options are available:

• **Scenes with zoom/pan**: Adds a crossfade effect between the clips created when you apply the Magic Cut effect.

• **Scenes with people speaking**: Selects clips with more or less dialog.

• **Scenes with moving objects**: Selects clips with more or less moving objects.

• **Duration of scenes**: Cuts the original video into longer or shorter clips. Drag the slider to set the duration of the scenes.

**Magic Fix**

Magic Fix can stabilize videos taken with shaky hands. You can increase or decrease the level of correction, depending on the severity of the shaking. Magic Fix also can automatically detect faces and remove red-eyes, and enhance the focus on photos that are out of focus.

**Perform Magic Fix on a Video Clip**

When applied to video clips, PowerDirector’s Magic Fix tool stabilizes videos taken with shaky hands. Magic Fix employs motion compensation technology to correct shaking in the videos. This tool is ideal for use with videos taken without a tripod or videos recorded on the move.
To perform Magic Fix on a video clip, select the clip in the timeline, then click . The Magic Fix pane opens.

The following options are available:

- **Apply Video Stabilizer**: Check this option to correct shaky video. Drag the slider to increase or decrease the level of correction.

- **Compare video qualities in split preview**: Check this option to compare your changes in a split preview.

- **Apply to all video clips**: Check this option to apply your changes to all the video clips in the project.

**Perform Magic Fix on a Photo Clip**

When applied to photo clips, PowerDirector’s Magic Fix tool removes red-eyes and enhances photos. Magic Fix employs detection technology to automatically detect faces and correct red-eyes. It also can enhance the focus on photos that are out of focus. This tool is ideal for use with photos taken during the night time or without a tripod.
To perform Magic Fix on a photo, select the clip in the timeline, then click ✅. The Magic Fix pane opens.

The following options are available:

- **Remove Red-Eyes**: Check this option to automatically detect faces and remove red-eyes.
- **Apply Re-focus**: Check this option to enhance the focus on a photo. Drag the slider to increase or decrease the level of enhancement.
- **Apply to all photo clips**: Check this option to apply your changes to all the photo clips in the project.

**Magic Style**

Magic Style creates professional movies with pre-designed style templates automatically. Magic Style includes pre-designed opening sequences, transitions, and effects to automatically generate professional-looking movies on your timeline. The Magic Style tool is perfect for use when you want to create great looking movies without the hassle of setting up the opening title, video effects and transitions yourself.
To add a Magic Style to the timeline, do this:

1. Select one or more video clips in the timeline, then click . The Magic Style pane opens.

2. Select a Magic Style Template from the Library.

3. Click the Preview button to preview the result in the Preview window.

4. Click Apply to apply the template to the clip and update the timeline. You can modify the elements created by Magic Style later.

**Note:** Magic Style Templates can be expanded through Online purchases. Please see Upgrade Your Software on p.7 for more details.

**Magic Music**

Magic Music automatically adjusts the playback of the music clips it contains to fit any length from 5 seconds to 2 hours, and fine-tunes the audio for a smooth cut-off. The Magic Music tool is ideal for use with photo slide shows.

**Note:** Click the SmartSound button to view SmartSound-related copyright and purchasing information.

To add a Magic Music audio clip to the timeline, do this:

2. Select a style from the drop-down menu.
3. Choose a song.
4. Set the desired duration in the duration box.
5. Select a variation, then drag it into the Music track.
6. Drag the clip’s border to a suitable duration.
Modifying Effects

Most effects boast a number of options that you can set individually to increase or decrease the intensity of the effect, or to achieve more creative results. In fact, this section describes some of the most creative functions found within the PowerDirector program. Mastering the procedures found in this section will go a long way towards making you a digital video editing expert!
**Set an Effect’s Duration**

The procedure below describes how to set the duration of a video, title, or transition effect. The procedure for PiP effects has only a slight difference.

**Set an Effect’s Duration Using the Duration Setting Box**

To set an effect’s duration using the Duration Setting box, do this:

1. Select the effect you want to modify.
2. Display the timecode box. You may do this in one of the following ways:
   - **Video/title/transition effects**: Click **Duration**. The Duration Setting dialog opens.
   - **PiP effects**: Click **Trim**. The PiP Trim Options panel opens, displaying the timecode box in the upper right-hand corner.

**Note**: To set a PiP effect’s duration using the Trim options, see Trim a Video or Audio Clip on p.83.

3. Set the duration, then do one of the following:
   - **Video/title/transition effects**: Click **OK**.
   - **PiP effects**: Click ✗ to close the options panel and return to the normal Library view.
Set an Effect’s Duration Manually

You can set an effect’s duration manually by dragging the edges of the effect in the Timeline. The procedure for dragging the edges of an effect is the same for video, title, PiP, and transition effects.

**Note:** Video clips used in a PiP cannot be lengthened beyond their original duration. Transitions can be lengthened to half of the duration of the shortest clip they affect.

To set an effect’s duration manually, do this:

1. Select the effect whose duration you want to set manually.
2. Position your cursor at one end of the effect and drag the end of the clip to the new position.

**Note:** You can drag the edge of a clip to lengthen it or to shorten it. If you compress the start of a video or audio clip, playback begins at a later frame within the clip. If you compress the ending, playback ends at an earlier frame within the clip.
Modifying a Video Effect

Video effects are applied to the Effect track at the time position of the video or image clip(s) that you want to affect. Video effects only affect the clips in the Video track that appear within the effect’s duration.

To modify a video effect, do this:

1. Select the video effect in the Effect track and click **Modify**. The Effect Modifications Options panel opens.

2. Set the intensity level of the video effect. A preview of the effect appears in the preview window. (Options vary according to the video effect you select.)
   - Many options provide a slider to increase or decrease the intensity of the effect.
   - Some effects provide a drop-down list in which you can choose an effect option.
   - Click **** to change two settings in proportion with each other.
   - Click **Reset** to restore the original effect settings.

3. Click **** to close the options panel and return to the normal Library view.
Modifying a PiP Effect

A picture-in-picture effect allows you to insert an image or a video into an existing image or video clip in your movie, effectively overlaying the picture-in-picture clip on top of the existing clip. You can modify the degree of transparency of the overlapping clip, as well as its position, motion, and other properties.

PiP effects have many options that you can modify independently. These include a border, a shadow, a motion effect, a color filter, size and position, and transparency.

Change the Speed of a PiP Effect

Slow-motion or fast-motion effects can grab your audience’s attention as well as break up the rhythm of a movie.

To change the speed of a PiP effect, do this:

1. Select the PiP effect video clip that you want to modify.
2. Click Speed. The speed option panel opens.
3. Drag the slider to set the new speed (between .1x and 10x).
4. Click to close the option panel.
Add a Border to a PiP Effect

You can add a border around the clip in a PIP effect. Available options allow you to change the border’s color and size and to add a transparency or blur effect.

To change the border of a PiP effect, do this:

1. Select the PiP effect video clip that you want to modify, then click **Modify**. The PiP Modification Options panel opens.
2. Click ![PiP Designer](image). The PiP Designer opens.

3. Set the PiP border options that you want to apply:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Apply border</strong></td>
<td>Check to apply the font face settings. Uncheck to remove the font face settings.</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td>Drag the slider to increase or decrease the size of the border.</td>
</tr>
<tr>
<td><strong>Blur</strong></td>
<td>Drag the slider to increase or decrease the blur effect of the border.</td>
</tr>
<tr>
<td><strong>Transparency</strong></td>
<td>Drag the slider to increase or decrease the transparency of the border.</td>
</tr>
</tbody>
</table>
Note: Whenever you set an option in the PiP Designer, a preview of the effect is instantly displayed.

4. Click OK to close the PiP Designer.
Add a Shadow to a PiP Effect

You can add a shadow around the clip in a PiP effect. Available options allow you to change the shadow’s color and size and to add a transparency or blur effect.

To add a shadow to a PiP effect, do this:

1. Select the PiP effect video clip that you want to modify, then click Modify. The PiP Modification Options panel opens.
2. Click . The PiP Designer opens.

3. Set the PiP shadow options that you want to apply:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply shadow</td>
<td>Check to apply the shadow settings. Uncheck to remove the shadow settings.</td>
</tr>
<tr>
<td>Distance</td>
<td>Drag the slider to increase or decrease the distance between the shadow and the font face.</td>
</tr>
<tr>
<td>Blur</td>
<td>Drag the slider to increase or decrease the blur effect of the shadow.</td>
</tr>
</tbody>
</table>
Note: Whenever you set an option in the PiP Designer, a preview of the effect is instantly displayed.

4. Click **OK** to close the PiP Designer.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transparency</td>
<td>Drag the slider to increase or decrease the transparency of the shadow.</td>
</tr>
<tr>
<td>Color picker</td>
<td>Click the eyedropper to open the Color dialog box, in which you can select the color of the shadow.</td>
</tr>
<tr>
<td>Shadow direction</td>
<td>Click a dimple to indicate the direction of the shadow.</td>
</tr>
</tbody>
</table>
Add Motion to a PiP Effect

You can add a motion to the clip in a PiP effect. Available options allow you to set the start and end locations, add a fade-in or fade-out, and begin or end the effect off screen.

To add motion to a PiP effect, do this:

1. Select the PiP effect video clip that you want to modify, then click Modify. The PiP Modification Options panel opens.

2. Click . The PiP Designer opens.

3. Set the PiP motion options that you want to apply:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PiP starting position</td>
<td>Select the position at which you want the PiP clip to begin its motion from the drop-down list. (Select Still if you do not want the PiP clip to move at the beginning of the effect.)</td>
</tr>
<tr>
<td>Start off screen</td>
<td>Check this option if you want the PiP clip to begin off screen.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Fade-in</td>
<td>Check this option if you want the PiP clip to fade in at the beginning of the effect.</td>
</tr>
<tr>
<td>PiP ending position</td>
<td>Select the position at which you want the PiP clip to end its motion from the drop-down list. (Select <strong>Still</strong> if you do not want the PiP clip to move at the end of the effect.)</td>
</tr>
<tr>
<td>End off screen</td>
<td>Check this option if you want the PiP clip to end off screen.</td>
</tr>
<tr>
<td>Fade-out</td>
<td>Check this option if you want the PiP clip to fade out at the end of the effect.</td>
</tr>
</tbody>
</table>

**Note:** Whenever you set an option in the PiP Designer, a preview of the effect is instantly displayed.

4. Click **OK** to close the PiP Designer.
Add a Color Filter to a PiP Effect

When you add a color filter to a clip in a PiP effect, portions of the underlying clip show through the overlaid clip wherever the selected color occurs.

1. Click the media clip in the PiP track you want to modify, then click **Modify**. The PiP Modification Options panel opens.
2. Check **Apply color filter**. This filters the selected color out of the image (i.e.: makes that color transparent).
3. Click the eyedropper tool. A dialog box opens, in which you can select a color from the media clip in your PiP effect.
4. Select the color from the clip that you would like to make transparent, then click **OK**.
   - To select more accurately, you can zoom in or out of the image. To do this, click **select a magnification percentage**
from the drop-down list, then click the button to zoom in or the button to zoom out.

5. Set a **Tolerance** level to extend or restrict the range of colors affected by the filter. Do this in one of the following ways:
   - Drag the Tolerance level slider.
   - Click the button to increase the level or the button to decrease the level.

6. Click **X** to close the options panel and return to the normal Library view.
Modify a PiP Effect’s Size and Position

You can change both the size and the position of the media clip in a PiP effect. Resizing options are unrestricted. You can reduce the clip to miniature size or enlarge it to completely obscure the underlying media file.

To modify a PiP effect’s size and position, do this:

1. Click the media clip in the PiP track, then click Modify. The PiP Modification Options panel opens.
2. Modify the PiP clip’s size and position in the preview window:
   a. Drag the PiP clip to a desired location over the underlying clip.
   b. Drag the edge of the PiP clip to a desired size. Check Keep aspect ratio to constrain the ratio of the length and width of the PiP clip. Uncheck this option to change the aspect ratio freely.
3. Click  to close the options panel and return to the normal Library view.

Modify a PiP Effect’s Transparency Level

You can modify the transparency level of the media clip in a PiP effect. Transparency options range from entirely transparent to totally opaque.

To modify a PiP effect’s transparency level, do this:

1. Click the media clip in the PiP track, then click Modify. The PiP Modification Options panel opens.
2. Set the Transparency level to increase or decrease the transparency of the superimposed clip.
3. Click  to close the options panel and return to the normal Library view.
Modify a Title Effect

Using title effects allows you to add text to your movie - as a title at the beginning, an element during the main story, or as credits at the very end. Besides changing the look of the text itself, you can also send the text running on a path across the screen. Title effects only affect the clips in the Video track that appear within the effect’s duration.

Title effects contain character presets, animation and background options, which you can modify to best suit your movie. All of these options are found in the Title Designer.

Apply a Character Preset Template to a Title Effect

You can apply a pre-defined template to a title effect. After you have applied the pre-defined template you can go to font face, shadow, or border settings to make changes to the title effect.

1. Select a title effect in the Title track, then click Modify. The Title Designer opens.

2. Click the tab.

3. Click to open the Character Presets Template settings.

4. Select the template that you want to apply.
Click  to save the currently selected template as My favorites.

Modify a Title Effect’s Font Face

You can modify the font used in a title effect, including the size, color, font type used, weight, alignment, transparency, and blur effect. Further tools aid in the precise positioning of the title on the screen and indicate the on-screen area that is safe for TV display.

1. Select a title effect in the Title track, then click Modify. The Title Designer opens.

2. Click tab.
3. Click to open the font face settings if it is not already opened.
4. Set the text font face options that you want to apply

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arial</td>
<td>Click to select a font type.</td>
</tr>
<tr>
<td>24</td>
<td>Click to select a font size.</td>
</tr>
<tr>
<td>B</td>
<td>Click to make text bold.</td>
</tr>
<tr>
<td>I</td>
<td>Click to make text Italicized.</td>
</tr>
<tr>
<td></td>
<td>Click to left-align text.</td>
</tr>
<tr>
<td></td>
<td>Click to center-align text.</td>
</tr>
<tr>
<td></td>
<td>Click to right-align text.</td>
</tr>
<tr>
<td></td>
<td>Click to undo changes.</td>
</tr>
<tr>
<td></td>
<td>Click to redo changes.</td>
</tr>
<tr>
<td></td>
<td>Click to bring selected object forward.</td>
</tr>
<tr>
<td></td>
<td>Click to send selected object backward.</td>
</tr>
<tr>
<td></td>
<td>Click to insert a new title.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>![Image]</td>
<td>Click to insert a new image.</td>
</tr>
<tr>
<td>![Cut]</td>
<td>Click to cut selected object.</td>
</tr>
<tr>
<td>![Copy]</td>
<td>Click to copy selected object.</td>
</tr>
<tr>
<td>![Paste]</td>
<td>Click to paste selected object.</td>
</tr>
<tr>
<td>![Grid Lines]</td>
<td>Click to add/remove grid lines that can aid in the precise positioning of text on the screen. Grid lines do not appear when you preview or produce your movie.</td>
</tr>
<tr>
<td>![TV Safe Zone]</td>
<td>Click to add/remove the TV Safe Zone outline, which represents the area in which video content from your movie is certain to appear on TV screens, which have a smaller display area than computer monitors. The TV Safe Zone outline does not appear when you preview or produce your movie.</td>
</tr>
<tr>
<td><strong>Apply font face</strong></td>
<td>Check to apply the font face settings. Uncheck to remove the font face settings.</td>
</tr>
<tr>
<td><strong>Blur</strong></td>
<td>Drag the slider to increase or decrease the blur effect of the font face.</td>
</tr>
</tbody>
</table>
Option | Description
--- | ---
Transparency | Drag the slider to increase or decrease the transparency of the font face.
Uniform color | Check to set the font face in a single color. Click the eyedropper to open the Color dialog box, in which you can select a color.
Gradient color | Check to set the font face in a color gradient.
Begin | Click the eyedropper to open the Color dialog box, in which you can select the color at the start of the gradient.
End | Click the eyedropper to open the Color dialog box, in which you can select the color at the end of the gradient.
Gradient direction | Click a dimple to indicate the direction of the gradient.

**Note:** Whenever you set an option in the Title Designer, a preview of the effect is instantly displayed.

5. **Click OK** to close the Title Designer.
Add a Shadow to a Title Effect

You can add a shadow around the text in a title effect. Available options allow you to change the shadow’s color and size and to add a transparency or blur effect.

1. Select a title effect in the Title track, then click **Modify**. The Title Designer opens.

2. Click the **Aa** tab.

3. Click ![Shadow](image) to open the Shadow settings.

2. Set the text shadow options that you want to apply:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply shadow</td>
<td>Check to apply the shadow settings. Uncheck to remove the shadow settings.</td>
</tr>
<tr>
<td>Distance</td>
<td>Drag the slider to increase or decrease the distance between the shadow and the font face.</td>
</tr>
<tr>
<td>Blur</td>
<td>Drag the slider to increase or decrease the blur effect of the font face.</td>
</tr>
</tbody>
</table>
3. Click **OK** to close the Title Designer.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Transparency</strong></td>
<td>Drag the slider to increase or decrease the transparency of the font face.</td>
</tr>
<tr>
<td><strong>Fill shadow</strong></td>
<td>Check to fill in the gap between the shadow and the font face.</td>
</tr>
<tr>
<td><strong>Color picker</strong></td>
<td>Click the eyedropper to open the Color dialog box, in which you can select the color of the shadow.</td>
</tr>
<tr>
<td><strong>Shadow direction</strong></td>
<td>Click a dimple to indicate the direction of the shadow.</td>
</tr>
</tbody>
</table>
Apply a Border to a Title Effect

You can add a border around the text in a title effect. Available options allow you to change the border’s color and size and to add a transparency or blur effect.

1. Select a title effect in the Title track, then click Modify. The Title Designer opens.

1. Click the Aa tab.

1. Click to open the Border settings.

2. Set the text border options that you want to apply:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply border</td>
<td>Check to apply the border settings. Uncheck to remove the border settings.</td>
</tr>
<tr>
<td>Size</td>
<td>Drag the slider to increase or decrease the size of the border.</td>
</tr>
<tr>
<td>Blur</td>
<td>Drag the slider to increase or decrease the blur effect of the border.</td>
</tr>
</tbody>
</table>
Click **OK** to close the Title Designer.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Transparency</strong></td>
<td>Drag the slider to increase or decrease the transparency of the border.</td>
</tr>
<tr>
<td><strong>Uniform color</strong></td>
<td>Check to fill in the gap between the border and the font face.</td>
</tr>
<tr>
<td><strong>Gradient color</strong></td>
<td>Click the eyedropper to open the Color dialog box, in which you can select the color of the border.</td>
</tr>
<tr>
<td><strong>Start color</strong></td>
<td>Click the eyedropper to open the Color dialog box, in which you can select the color at the start of the gradient.</td>
</tr>
<tr>
<td><strong>End color</strong></td>
<td>Click the eyedropper to open the Color dialog box, in which you can select the color at the start of the gradient.</td>
</tr>
<tr>
<td><strong>Gradient direction</strong></td>
<td>Click a dimple to indicate the direction of the shadow.</td>
</tr>
</tbody>
</table>
Apply Animation to a Title Effect

You can apply animations to a title effect. Animations can be applied to all the text objects in the title effect or to individual text objects in the title effect. You can apply either a beginning animation, an ending animation or both.

1. Select a title effect in the Title track, then click Modify. The Title Designer opens.

2. Click the tab.

3. Select the text object you wish to animate in the Objects list.

**Note:** Check Display the selected object only if you wish to only view the object you have selected in the preview window.

4. Click Beginning Animation to open the Beginning Animation dialog box.

5. Choose a beginning animation sequence and click OK.

6. Click Ending Animation to open the Ending Animation dialog box.

7. Choose an ending animation sequence and click OK.

8. Preview your animation in the preview window and click OK to confirm your changes.
Apply Background Image to a Title Effect

You can apply your own background images to a title effect. Background image is applied to the entire title effect.

1. Select a title effect in the Title track, then click Modify. The Title Designer opens.

2. Click the tab.

3. Select the background you wish to use from the Background Image list.
   - If you don’t see a background image you like you can use your own image. Click to add a new image.

4. Preview your change in the preview window and click OK to confirm your change.
Preview a Clip

As you add media to your production, it is important to preview the effect your media clips have on the story you are telling. You may want to preview imported clips, for example, to verify their content, or to preview clips you have captured to see if they contain sections you need to trim.

Preview Window

The easiest way to preview a media clip is by playing it in the preview window to the right of the Library. Any media clip that appears in the Library or the workspace can be previewed in this window. However, playback controls are only available for video and audio media.
Preview a Clip in the Preview Window

To preview a media clip in the preview window, do this:

1. Click the clip or effect you want to preview. The clip appears in the preview window.

Note: When previewing clips in the workspace, ensure that the preview window is in Clip mode. If the preview is in Movie mode, click the Clip button before previewing a clip.

2. Locate the point at which you want to begin your preview. You may do this in one of the following ways:
   - Drag the Timeline slider.
   - Drag the preview window slider.
   - Enter a timecode in the timecode box.

3. Press . The preview starts from the point you have specified.

4. Use the playback buttons to control the preview.

Preview an Effect in the Preview Window

Previewing effects is an important step in ensuring not only that the effect is applied to the proper clip in the proper location, but that the intensity of the effect is suitable for that location in the movie. You will likely preview effects constantly as you apply them to the workspace, and it is a good idea to preview your movie at regular intervals to ensure that your editing is proceeding as you planned.

To preview an effect in the preview window, do this:

1. Click the effect in the Timeline. The media clip the effect is applied to appears in the preview window.

2. Locate the point at which you want to begin your preview. You may do this in one of the following ways:
   - Drag the Timeline slider.
   - Drag the preview window slider.
   - Enter a timecode in the timecode box.

3. Press . The preview starts from the point you have specified.
4. Use the playback buttons to control the preview.

**Media Viewer**

The Media Viewer is similar to the preview window but offers additional functions for trimming video clips. Previewing clips in the Media Viewer gives you a larger preview picture than the preview window.

The Media Viewer also allows you to preview media clips as well as your entire movie production in a large, resizable window. You can configure the preview resolutions and select between instant preview or rendering preview.

- **Preview window**
  - Provides playback controls to preview your movie

- **Playback controls**
  - Allow you to control playback of clips
Preview a Clip in the Media Viewer

To preview a clip in the Media Viewer, do this:

1. Select the clip in the Timeline. The clip appears in the Preview window.

2. Click in the preview window. Select Instant Preview with Media Viewer. The clip appears in the Media Viewer.

Note: You may also use Rendering Preview with Media Viewer, however the rendering process takes a long to complete

3. Locate the point at which you want to begin your preview. You may do this in one of the following ways:
   - Drag the Timeline slider.
   - Drag the preview window slider.
   - Enter a timecode in the timecode box.

4. Press . The preview starts from the point you have specified.

5. Use the playback buttons to control the preview.

Note: Use the slider in the magnified timeline for more precise preview control.

Preview an Effect in the Media Viewer

To preview an effect in the Media Viewer, do this:

1. Click the effect in the Timeline.

2. Click in the preview window. Select Instant Preview with Media Viewer. The clip appears in the Media Viewer.

Note: You may also use Rendering Preview with Media Viewer to preview a rendered movie, however the rendering process takes a long to complete

3. Locate the point at which you want to begin your preview. You may do this in one of the following ways:
   - Drag the Timeline slider.
• Drag the preview window slider.
• Enter a timecode in the timecode box.

4. Press ➤. The preview starts from the point you have specified.
5. Use the playback buttons to control the preview.

**Note:** Use the slider in the magnified timeline for more precise preview control.
Chapter 5: Producing Your Movie

After your movie has been completely edited, you are ready to produce your movie. Producing a movie simply means compiling (or rendering) the separate elements it contains into one playable movie file. As your movie can be destined for different uses, PowerDirector has several options to produce movies suited to any need.

This chapter contains the following sections:

- Production Mode on p.142
- The Production Wizard on p.143
- Create a File on p.145
- Create a Streaming File on p.166
- Write Back to DV Tape on p.175
Production Mode

When you click the button, PowerDirector enters Production mode, in which you can compile your movie into a file that is ready for a variety of destinations, including burning to disc. In Production mode, PowerDirector opens the Production Wizard.

Preview window
Provides playback controls to preview your movie

Production mode buttons

Information display area

Information display area
The Production Wizard

The Production Wizard is a simple interface that makes movie production easy. When you click , the Production Wizard opens.

Note: Before producing your movie, make sure that all of your video clips have the same interlacing format. This is an extremely important step to take before production, as it can drastically affect final video quality! If you produce your movie and find the video quality unsatisfactory, verify that the interlacing format of all of your video clips is the same. If your clips have different interlacing formats, set them all to the same format, then produce your movie again. For more information, see Set a Video Clip’s Interlacing Format on p.92.
The opening window contains a preview window, a visual display of your hard disk space, and three buttons corresponding to the three production options available in The Production Wizard. These are described below:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a File</td>
<td>Allows you to create a movie production that you can then watch on your computer. See Create a File on p.145.</td>
</tr>
<tr>
<td>Create a Streaming File</td>
<td>Allows you to create a movie production that you can then stream over the Internet. See Create a Streaming File on p.166.</td>
</tr>
<tr>
<td>Write Back to DV Tape</td>
<td>Allows you to create a movie production that you can then write back to DV tape. See Write Back to DV Tape on p.175.</td>
</tr>
</tbody>
</table>
Create a File

You may want to produce your movie as a file that you can watch on your computer. PowerDirector allows you to create files in AVI, MPEG-1, or MPEG-2 format. The procedures for creating each of these file types are described in the section below.

Create an AVI File

There are two types of AVI files: DV-AVI or Windows AVI.

DV-AVI

To produce a DV-AVI movie that you can watch on your computer, do this:

1. Click \[\text{Produce}\] to open the Production Wizard.

2. Click \[\text{File}\], then \[\text{file generation production options appear on the page}\].

3. Select the AVI file format.

4. Select the DV-AVI format from the drop-down list.

5. Select NTSC or PAL from the drop-down list.
- **Use SVRT to save rendering time**: Keep this option checked (when it is enabled) to reduce production time. For more information on SVRT, see What is SVRT/SVRT II and when can I use it? on p.206 and SVRT, SVRT II on p.220.

6. Click . A dialog box opens. Set your options, if necessary:

   - Select **Type I** or **Type II**. For more information on these two types, see Type I and Type II on p.221.
   - Select **High Quality** or **Medium Quality**. For more information on video quality, see Video Qualities on p.216.
   - To review your production settings, click . A dialog box opens, in which you can verify the profile’s details.
7. Click ➡️. Production details appear on the page. Verify that these details are correct.

- You can change the video file name and destination folder. To do this, click ➡️, then enter a new name or locate a new folder.
- To ensure that all of your video clips have the same interlacing format, click **Scan source video clips and set field order**.

8. Click ➡️. The production process begins. This process may take a few minutes.
- To stop the production process before completion, click ✖️.
- To return to Edit mode after production is complete, click 🏠.
Windows AVI

To produce a Windows AVI movie that you can watch on your computer, do this:

1. Click  to open the Production Wizard.

2. Click , then . File generation production options appear on the page.

3. Select the AVI file format.

4. Select the Windows AVI format from the Profile Type drop-down list.

5. Select a video quality from the Profile Name drop-down list.
   - To review your production settings, click . A dialog box opens, in which you can verify the profile’s details.
6. Click ✉️. Production details appear on the page. Verify that these details are correct.

- You can change the video file name and destination folder. To do this, click ⬤, then enter a new name or locate a new folder.

- To ensure that all of your video clips have the same interlacing format, click **Scan source video clips and set field order**.

7. Click ✅. The production process begins. This process may take a few minutes.

- To stop the production process before completion, click ❌.

- To return to Edit mode after production is complete, click 🏠.
Create a DivX File

You can create a DivX file for a number of different uses: as an email attachment, for playback on a media player, for viewing on a TV, or for writing to VHS tape.

To produce a DivX movie, do this:

1. Click to open the Production Wizard.
2. Click , then . File generation production options appear on the page.
3. Select the DivX file format.
4. Select a video quality from the Profile Name drop-down list.
• To review your production settings, click \( 
\). A dialog box opens, in which you can verify the profile’s details.

![Dialog box](image)

5. Click \( \). Production details appear on the page. Verify that these details are correct.

![Production details](image)

• You can change the video file name and destination folder. To do this, click \( \), then enter a new name or locate a new folder.
• To ensure that all of your video clips have the same interlacing format, click **Scan source video clips and set field order**.

6. Click \( \). The production process begins. This process may take a few minutes.
• To stop the production process before completion, click.
• To return to Edit mode after production is complete, click.

Create an MPEG-1/MPEG-2 File

To produce an MPEG-1/MPEG-2 movie that you can watch on your computer, do this:

1. Click to open the Production Wizard.
2. Click, then . File generation production options appear on the page.

3. Select the MPEG-1/MPEG-2 file format.
4. Select a Country/Video format from the Country/Video Format drop-down list.
5. Select a profile type from the Profile Type drop-down list.
6. Select a video quality from the Profile Name drop-down list.
• To review your production settings, click . A dialog box opens, in which you can verify the profile’s details.

![Dialog box showing production settings](image)

7. Click . Production details appear on the page. Verify that these details are correct.

![Production details page](image)

• You can change the video file name and destination folder. To do this, click , then enter a new name or locate a new folder.

• To ensure that all of your video clips have the same interlacing format, click **Scan source video clips and set field order**.

8. Click . The production process begins. This process may take a few minutes.
To stop the production process before completion, click \[\text{X}\].

To return to Edit mode after production is complete, click \[\text{Home}\].

Create a PSP File (Optional)

To produce a PSP movie that you can watch on your Sony PSP, do this:

1. Click \[\text{Produce}\] to open the Production Wizard.

2. Click \[\text{→}\], then \[\text{→}\]. File generation production options appear on the page.

3. Select the PSP file format.

4. Select a video quality from the \text{Profile Name} drop-down list.

   - Click \[\text{→}\]. A dialog box opens. Set the text you wish to display in your movie, if necessary.
To review your production settings, click 🔄. A dialog box opens, in which you can verify the profile’s details.

<table>
<thead>
<tr>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Video Codec</td>
</tr>
<tr>
<td>Bit rate</td>
</tr>
<tr>
<td>Width</td>
</tr>
<tr>
<td>Height</td>
</tr>
<tr>
<td>GOP Pattern</td>
</tr>
<tr>
<td>Audio Codec</td>
</tr>
<tr>
<td>Audio Mode</td>
</tr>
</tbody>
</table>

5. Click 🔄. Production details appear on the page. Verify that these details are correct.

- You can change the video file name and destination folder. To do this, click 🔄, then enter a new name or locate a new folder.
- To ensure that all of your video clips have the same interlacing format, click **Scan source video clips and set field order**.

6. Click 🔄. The production process begins. This process may take a few minutes.
• To stop the production process before completion, click 

• To return to Edit mode after production is complete, click 

Create an AVC File (Optional)

To produce an AVC MPEG4 movie that you can watch on your computer, do this:

1. Click 

2. Click , then . File generation production options appear on the page.

3. Select the AVC MPEG4 file format.
4. Select your Country/Video format from the Country/Video Format drop-down list.
5. Select a profile type from the Profile Type drop-down list.
6. Select a VIDEO quality from the Profile Name drop-down list.
• To review your production settings, click \[\text{Details}\]. A dialog box opens, in which you can verify the profile’s details.

7. Click \[\text{Details}\]. Production details appear on the page. Verify that these details are correct.

• You can change the video file name and destination folder. To do this, click \[\text{Details}\], then enter a new name or locate a new folder.

• To ensure that all of your video clips have the same interlacing format, click \text{Scan source video clips and set field order}.

8. Click \[\text{Scan source video clips and set field order}\]. The production process begins. This process may take a few minutes.
- To stop the production process before completion, click [image].
- To return to Edit mode after production is complete, click [image].
Create/Modify a Profile

You can create a new profile, or modify an existing profile’s settings, in order to better suit your production needs.

Modify Windows AVI Profile Settings

1. Click . A dialog box opens. Set your options, if necessary:

   - **Compression Codec**: Select a codec from the drop-down list.
   - **Key Frame**: This field, when available, allows you to set the number of key frames in your video, but this number cannot be set for most codecs. For more information on key frames, see key frame on p.218.
   - **Data Rate**: Select a data rate from the drop-down list.
   - **Composition**: Select the media type to be compressed in your final movie production: Video and audio, Video only, or Audio only.
   - The **Codec Settings...** and **About** buttons open dialog boxes with options and information about the individual compression/decompression schemes.
   - **Better Compression/Better Quality**: Drag the slider to select a setting between smaller production file size and better video quality.
2. Click the Video/Audio Settings tab and set your options, if necessary:

- **Frame(s)**: Select a frame rate from the drop-down list.
- **Video Size**: Select a video display size from the drop-down list.
- **Colors**: Select a color scheme from the drop-down list.
- **Format**: Select an audio format from the drop-down list.
- **Attributes**: Select audio attributes from the drop-down list.
- To verify the profile’s properties, click . A dialog box opens, in which you can verify the profile’s details.
Modify DivX Profile Settings

1. Click . A dialog box opens. Set your options, if necessary:

   - **Compression Codec**: Select a codec from the drop-down list.
   - **Key Frame**: This field, when available, allows you to set the number of key frames in your video, but this number cannot be set for most codecs. For more information on key frames, see key frame on p.218.
   - **Data rate**: Select a data rate from the drop-down list.
   - **Composition**: Select the media type to be compressed in your final movie production: **Video and audio**, **Video only**, or **Audio only**.
   - The **Codec Settings**... and **About** buttons open dialog boxes with options and information about the individual compression/decompression schemes.
   - **Better Compression/Better Quality**: Drag the slider to select a setting between smaller production file size and better video quality.
2. Click the Video/Audio Settings tab and set your options, if necessary:

- **Frame(s):** Select a frame rate from the drop-down list.
- **Video Size:** Select a video display size from the drop-down list.
- **Colors:** Select a color scheme from the drop-down list.
- **Format:** Select an audio format from the drop-down list.
- **Attributes:** Select audio attributes from the drop-down list.
- To verify the profile’s properties, click ![OK button](image). A dialog box opens, in which you can verify the profile’s details.
Create a New MPEG-1/MPEG-2 Profile

MPEG production profiles can be used when you produce a movie for a disc or when you create an MPEG-1 or MPEG-2 file. You can create custom production profiles if none of the existing profiles suit your specific production requirements.

To create a new custom production profile, do this:

1. Click . The Profile Setup dialog box appears.

2. Enter a new profile name.
3. Click the Video tab and modify the video options, if necessary:

   - **Video Size**: Select a video display size from the drop-down list.
   - **Video Compression Bitrate**: Drag the slider to increase or decrease video bitrate. An increased bitrate (set by dragging the slider to the right) results in a larger file size and increased production time.
- **Smoothing**: Check to produce a softer video image. Only use this option if it was not used during capture, as it can result in slightly blurred video quality.
- **Noise removal**: Check to remove video artefacts. Only use this option if it was not used during capture, as it can result in slightly blurred video quality.
- **Deinterlacing**: Check to create deinterlaced video. Deinterlacing improves the quality of interlaced video when displayed on a computer monitor, but does may degrade video quality in other cases.
- **High speed/High quality**: Drag the slider to select an acceptable setting between faster production speed with lower video quality and higher video quality with slower production speed.

4. Click the Audio tab and modify the audio option, if necessary:

   ![Audio Tab](image)

   - **Audio Compression Rate**: Select a rate from the drop-down list. A higher rate yields better audio quality, but results in a larger file and increased production time.

5. Click **OK** to close the dialog box.

   - To edit a custom production profile, click ![Edit](image) and edit the necessary information.
   - To delete a profile, click ![Delete](image). A warning message appears, asking if you want to delete the profile. Click **OK**. The profile is deleted.
   - To view a profile’s production details, select the profile whose details you want to view, then click ![View Details](image). The Details
dialog appears, displaying the profile’s details. Click **OK** to close the dialog.
Create a Streaming File

You may want to produce your movie as a video file that can be stored on a server for streaming over the Internet. PowerDirector allows you to create files in WMV, RealVideo, or QuickTime Movie format. The procedures for creating each of these file types are described in the section below.

Create a WMV File for Streaming

To produce a WMV movie that you can stream over the Internet, do this:

1. Click \(\text{Produce}\) to open the Production Wizard.

2. Click \(\text{WMV}\), then \(\text{Next}\). Streaming file production options appear on the page.

3. Select the WMV movie file format.

4. Select the movie setting that suits your production needs.

5. Click \(\text{Next}\). Production details appear on the page. Verify that these details are correct.
You can change the video file name and destination folder. To do this, click ..., then enter a new name or locate a new folder.

To ensure that all of your video clips have the same interlacing format, click **Scan source video clips and set field order**.

**Note**: This is an extremely important step to take before producing your final movie, as it can drastically affect final video quality!

6. Click . The production process begins. This process may take a few minutes.

   - To stop the production process before completion, click .
   - To return to Edit mode after production is complete, click .
Create a RealVideo File for Streaming

To produce a RealVideo movie that you can stream over the Internet, do this:

1. Click \[\text{Produce}\] to open the Production Wizard.

2. Click \[\text{RealVideo}\], then \[\rightarrow\]. Streaming file production options appear on the page.

3. Select the RealVideo movie file format.

4. Enter the file’s properties:
   - **Title**: Enter a title for your movie.
   - **Copyright**: Enter copyright information for your movie.
   - **Author**: Enter author information for your movie.
   - **URL**: Enter the URL from which the file is streaming.
   - **Seconds**: Enter the video length in seconds.
   - You can select a production profile. For more information on profiles, see Create a New RealVideo Profile on p.169.

5. Click \[\rightarrow\]. Production details appear on the page. Verify that these details are correct.
• You can change the video file name and destination folder. To do this, click ..., then enter a new name or locate a new folder.
• To ensure that all of your video clips have the same interlacing format, click **Scan source video clips and set field order**.

**Note:** This is an extremely important step to take before producing your final movie, as it can drastically affect final video quality!

6. Click ![green checkmark]. The production process begins. This process may take a few minutes.
   • To stop the production process before completion, click ![red X].
   • To return to Edit mode after production is complete, click ![home].

**Create a New RealVideo Profile**

To create a new custom production profile, do this:

1. Click ![profile]. The Profile Setup dialog box appears.

![Profile Setup dialog box]

2. Enter a new profile name.
3. Click the Settings tab and modify the Video, Audio, and Target Audience Settings, if necessary:

![Screenshot of Settings tab](image)

4. Click **OK** to close the dialog box.
   - To edit a custom production profile, click ![Edit arrow] and edit the necessary information.
   - To delete a profile, click ![Delete arrow]. A warning message appears, asking if you want to delete the profile. Click **OK**. The profile is deleted.
   - To view a profile’s production details, select the profile whose details you want to view, then click ![Details arrow]. The Details dialog appears, displaying the profile’s details. Click **OK** to close the dialog.
Create a QuickTime File for Streaming

To produce a QuickTime movie that you can stream over the Internet, do this:

1. Click to open the Production Wizard.

2. Click , then . Streaming file production options appear on the page.

3. Select the QuickTime movie file format.

4. Select a production profile. For more information on profiles, see Create a New QuickTime Profile on p.173.

5. Click . Production details appear on the page. Verify that these details are correct.
   - You can change the video file name and destination folder. To do this, click..., then enter a new name or locate a new folder.
   - To ensure that all of your video clips have the same interlacing format, click Scan source video clips and set field order.

Note: This is an extremely important step to take before producing your final movie, as it can drastically affect final video quality!
6. Click 🔄✔️. The production process begins. This process may take a few minutes.
   • To stop the production process before completion, click 🔄❌.
   • To return to Edit mode after production is complete, click 🏠.
Create a New QuickTime Profile

To create a new custom production profile, do this:

1. Click . The Profile Setup dialog box appears.

![Profile Setup dialog box]

2. Enter a new profile name.
3. Click the Video Compressor tab and set your Video Setting options:

   ![Video Compressor settings]

   - **Compressor Component**: Select a compression scheme display size from the drop-down list.
   - **Video Size**: Select a video display size from the drop-down list.
   - **Video Type**: Select a video codec type from the drop-down list.
   - **Video Quality**: Select a video quality from the drop-down list.
• **Key Frame Rate**: Use the arrows to set a key frame rate (between 0 and 32). For information on key frames, see key frame on p.218.

4. Click **OK** to close the dialog box.

• To edit a custom production profile, click 📝 and edit the necessary information.

• To delete a profile, click 🗑️. A warning message appears, asking if you want to delete the profile. Click **OK**. The profile is deleted.

• To view a profile’s production details, select the profile whose details you want to view, then click 📊. The Details dialog appears, displaying the profile’s details. Click **OK** to close the dialog.
Write Back to DV Tape

You may want to produce your movie in order to write it back to DV tape. This allows you to store your movie in a convenient, digital format that can easily be imported into another computer for further editing.

To produce a movie that you can write back to DV tape, do this:

1. Click \_\_Produce\_\_ to open the Production Wizard.

2. Click \_\_Next\_\_, then \_\_Next\_\_. Options for writing to disc appear on the page.

3. Click \_\_Finish\_\_.

Producing Your Movie
4. Click \( \text{↓} \). Production details appear on the page. Verify that these details are correct.

![Production Details Screen](image)

- You can change the video file name and destination folder. To do this, click \( \text{↓} \), then enter a new name or locate a new folder.

5. Click \( \text{↓} \). The production process begins. This process may take a few minutes.
  - To stop the production process before completion, click \( \text{↓} \).
  - To return to Edit mode after production is complete, click \( \text{↓} \).
6. When production is complete, the Write to DV Tape dialog box opens.

7. Locate the position at which you would like to begin writing to tape. You may do this in one of the following ways:
   - Use the playback buttons.
   - Drag the time slider.
   - Enter a timecode in the timecode box.

8. Your produced movie file appears in a list in the window.
   - Click to add new files to the file list. Select a file and click to remove it from the file list.
   - Select a file then click to bring it closer to the beginning of your movie when writing to tape. Click to move it toward the end.
   - To ensure that all of your video clips have the same interlacing format, click **Scan source video clips and set field order**.

**Note:** This is an extremely important step to take before producing your final movie, as it can drastically affect final video quality!

9. Click . A message appears asking you to ensure your tape is at correct location and not write-protected. (Writing back
to tape overwrite any content currently on the tape at that position.)

10. Click **Yes**. Writing begins.
    - Click **Abort** to stop.
    - If successful, a confirmation message appears.

11. Click **OK**.
Chapter 6:
Creating Disc

This chapter discusses how to create a video disc after your movie has been completely edited. You can burn your movie onto VCD or DVD discs in three simple steps. Integrated authoring allows you to view your movie in the living room instantly after you have produced your movie. You will never have to launch another program again to create a video disc.

This chapter contains the following sections:
- Create Disc Mode on p.180
- Customize Your Disc’s Menu Page on p.181
- Burn to Disc on p.188
Create Disc Mode

When you click the Create Disc button, PowerDirector enters Create Disc mode, in which you can burn your movie onto a VCD or DVD disc. In Create Disc mode, the program appears as follows:

The Create Disc mode is a simple interface that makes disc authoring easy. When you click Create Disc, the Create Disc interface opens.

The opening window contains an author/preview windows on the right, a list of options to customize your disc’s menu page, and three buttons on the bottom to view the disc summary, change your disc preference, and initiate the burning process.
Customize Your Disc’s Menu Page

Before you burn your movie to a disc, you must first create menus so that you can navigate around your disc. The Customize Menu pane gives you complete creative control over the look of your menu page. You can modify the appearance of the menu’s buttons, text, and overall layout. The layout of the Customize Menu options pane appears as follows:

Select a Menu Page Template

Menu page templates combine settings for background images, buttons, and frames.

To specify a background template for a menu page, do this:

1. Click **Template**.
   - To restrict display for easier selection, choose a category from the drop-down box, or select **All** to show all options.

2. Select the template you want to use. It will be automatically applied to the Preview window.
Specify the Number of Buttons Per Menu Page
To specify the number of buttons per menu page, do this:

1. Click **Buttons Per Page**.
2. Select the number of buttons you want per menu page. It will be automatically applied to the Preview window.

Select a Button Frame Style
To select a button frame style, do this:

1. Click **Frame**.
2. Select the button frame style you want to use. It will be automatically applied to the Preview window.

Select a Button Layout
To select a button layout, do this:

1. Click **Button Layout**.
2. Select the button layout you want to use. It will be automatically applied to the Preview window.

Select a Button Style
To select a button style, do this:

1. Click **Button Style**.
2. Select the button style you want to use. It will be automatically applied to the Preview window.

Download a Template
To download a template from CyberLink’s web site, do this:

1. Click **Templates**.
2. Click **Get More Templates** and a dialog box opens. Click **Buy Now** to be redirected to the CyberLink online store.
3. Purchase and download the template(s) you would like to use.

**Note:** You must be connected to the Internet to use this feature.
Save a Template as a Favorite File

If you modify the settings on the Customize Menu pane, you can save those settings as a Favorite (.fl) file for later use.

To save a template as a Favorite (.fl) file, click . In the dialog box that opens, save the Favorite file.

Open a Favorite File as a Template

After you save a template as a Favorite file, you can open it for use as a template.

To open a Favorite file as a template, click . In the dialog box that opens, open a Favorite (.fl) file.

Modify Menu Text

To edit text that appears on the menu page, double-click it in the Author mode, then enter the new text.

Note: Make sure you are in the Author mode.

To change the font properties of text that appears on the menu page, click the text, then click . In the dialog box that opens, change the font properties, then click OK.

Set Background Music

You may add an audio file in order to provide background music in your disc menu.

To add background music, do this:

1. Click in the Author mode.
2. The Choose Menu Background Music dialog box opens.

3. Click \(\text{open audio track}\) to open an audio track. You may edit the audio file you have selected. The following options are available, if desired:
   - Select a fade in/out option.
   - Select to auto repeat the audio file.
   - Trim the audio file using the sliders on the trim bar.
   - Adjust the volume.

4. Click \(\text{add audio track}\). The audio track appears in the Background music box.

   To remove the audio track, click \(\text{remove audio track}\).

   To add background music from Magic Music, click \(\text{add Magic Music}\). The procedure is the same as Magic Music tool. See Magic Music on p.108 for the steps to follow.

**Set a First Play Video Clip**

A clip designated as first play is the initial sequence that plays as soon as a disc is inserted into a computer for play, and before the menu page appears. No navigation buttons are available during the first play, and viewers cannot fast forward past this segment. In a professional production, first play typically consists of a copyright notice or warning. However, you may prefer to use a personal introduction or other video clip instead.
Creating Disc

To set a clip as first play, click 📻 and open the file that you want. Click 📻 to remove the file set as first play. Click 🎥 to preview the first play video.

View a Summary of Your Disc

To view a detailed summary of your disc, click 📀. The Summary dialog box opens listing the System Information and Production Information.

Modify Your Create Disc Preference

Click ⚠️ to modify your Create Disc Preference.

The following options are available under the Disc Format tab:

- **Disc Format**: Select the disc format you will be using to burn your movie.
• **Disc Capacity** (DVD only): Select the disc capacity of your DVD disc.

• **Video Quality** (DVD only): Select a video quality for your disc: DVD LP (Long Play), DVD SP (Standard Play), DVD HQ (High Quality), or Smart Fit. The video quality settings offer different bit rates, resulting in files of different size. The higher the quality of the video, the larger the resulting file and the shorter the length of video that can fit onto a disc. Further, more CPU power is required for rendering higher quality video. The **Smart Fit** option automatically adjusts the bit rate to the best quality video file that fits exactly to the capacity of the disc you are using.

• **Audio Type**: The different audio types are as follows: LPCM is an uncompressed audio format. Dolby Digital audio uses the Dolby Digital Consumer Encoder format. MPEG audio uses the MPEG-1 audio compression format. (This audio format may have compatibility issues in NTSC.)

**Note**: The video quality and audio type options that are available depend on the disc format that you have selected.

The following options are available under the **Menu** tab:

• **Add thumbnail index**: Check this option to add a thumbnail index to the menu.

• **Enable video thumbnail**: Check to allow chapter thumbnails to display video on the disc’s menu. If you select this option, you can limit the length of video that displays by entering a value for the **User-defined motion menu duration** option.
Default menu style: Specify your favorite style (.fl file) as the style for each new PowerDirector project.

The following option is available under the Audio tab:

Apply CyberLink VirtualSpeaker to enhance background music: Check this option to enable CyberLink VirtualSpeaker to enhance background music. Choose between Living Room, Theater, and Stadium.

Preview Your Disc’s Menu Page

Click Preview to preview your menu page. Click a button to preview the chapter associated with the button. Use the playback buttons to control the preview.

Click Author to return to the Author mode.
Burn to Disc

After you have acquired your media, assembled your story, edited your clips, added audio and visual effects, and customized the layout and look of your disc, then it’s time to finalize your production.

CyberLink PowerDirector offers several methods to finalize your production, which are useful under different circumstances. You can burn your production to disc as the last step in your movie production process, save your production as a disc image for later burning, or create a DVD folder to organize your media files on your hard drive. Depending on your burning drive and disc type, one or more of these options may be available simultaneously.

Set Your Burning Configuration

Before you burn to disc for the first time, set your burning configuration on the Burn window. After you set this configuration, PowerDirector uses the same configuration each time you burn until you change the settings.
To set your burning configuration, do this:

1. Click 🌞 to open the Burn window.

2. Click 🛠️. The Burning Configuration window opens.

3. Select your recording drive.
4. Select a recording speed.
   - The **Include buffer under-run protection** option ensures that your drive write without errors when your hard drive is busy or system resources are low.
5. Click **OK** to set your configuration and return to the Burn window.

**Burn Your Movie to Disc**

Burning your movie to disc is the final stage of the create disc process. Once it is burned, you will be able to play it on a disc player to share with your family and friends.

To burn your movie to disc, do this:

1. Check the **Burn to disc** option on the Burn window.
2. Specify your burning options:
   - Enter the number of copies you want to make.
   - To give the disc a volume label, enter the desired label.
3. Click **OK**. The task begins immediately. PowerDirector displays the real-time progress.

**Note:** The burning process may take at least a few minutes, depending on the length and quality of your video and your computer’s processing power. Be prepared for a short wait while PowerDirector renders your movie!

When the task is completed, a window appears, displaying a congratulatory message. Click **OK** to continue.

**Note:** HD Content captured from HDV camcorders will be converted to standard definition (SD) format when burning to DVD disc. This is because DVD accepts only SD format. HD format will be supported on the high capacity HD-DVD and Blu-ray discs when they become available.

**Create a DVD Folder**

Creating a DVD folder conveniently stores all the files that make up a movie in your hard drive so that it is ready for burning.

To create a DVD folder, do this:

1. Check the **Create a DVD folder** option.
2. Click , then select the directory where you want to save the DVD folder.

**Note:** Creating a DVD folder overwrites existing data in a directory.

3. Click **OK**. The task begins immediately. PowerDirector displays the real-time progress.

When the task is completed, a window appears, displaying a congratulatory message. Click **OK** to continue.

**Erase a Disc**

If you are using a rewritable disc, you can erase content that has been previously recorded onto it. This allows you to reuse the same discs over and over without the need to continually buy new discs. Most manufacturers suggest that current -RW/+RW rewritable discs can be written to about 1,000 times. DVD-RAM discs can be written to 100,000 times.

To erase a disc, do this:

1. Click . The Erase Disc Content window opens.

![](image)

2. Insert your disc and select your drive.
   - Click to refresh the display of your drive.
   - Click to open your disc drive door.
3. Select an erasing method.
   - The **Quick** option erases the disc index contained on the disc.
   - The **Full** option erases all of the content the disc contains.

4. Click 🌪️ to start. PowerDirector displays the real-time progress of the task.
Appendix

This chapter contains reference information to help answer questions you may have about the digital movie production process or about using CyberLink PowerDirector.

This chapter contains the following sections:

- Technical Support on p.194
- Hotkeys on p.196
- FAQ on p.205
- SVRT2: When Can I Use it? on p.209
- Disc Types & Formats on p.210
- Video Formats & Qualities on p.215
- Glossary on p.217
- Licensing and Copyright Notices on p.222
Technical Support

Before seeking technical support, please read your user's guide or online help, and check out the Readme file for more information. You may also contact your local distributor/dealer. If your problem is still not resolved, the following sections provide ways to obtain technical support from CyberLink.

Web Support

Web support is available 24 hours a day:
support.gocyberlink.com

In addition to frequently asked questions, our website also provides troubleshooting techniques, the latest in product news, and other relevant information.

Fax Support

In order to answer your technical questions as quickly as possible, you may fax us at:

(886) 2-8667-1300

Note: Technical support is only offered to registered users, so please make sure to include your CD-key when faxing.
Telephone Support

You are welcome to call CyberLink’s Technical Support Hotline at:

(886) 2-8667-1298

Note: Technical support is only offered to registered users, so please make sure your CD-key is ready when calling.

Phone support hours are:

Monday-Friday, 9:00 a.m. - 5:00 p.m. Taiwan local time (GMT +8:00) excluding holidays.

When calling for support, please have your computer ready and provide us with the following information:

- registered CD-key
- product version
- Windows version
- hardware types (capture card, sound card, VGA card) and their specifications
- warning messages displayed
- detailed problem description and when it occurred
# Hotkeys

PowerDirector allows you to employ a number of hotkeys to make working with video quicker and easier. These hotkeys are organized by function and described below.

## System Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt + space bar</td>
<td>Open the Minimize menu in the top-left corner</td>
</tr>
<tr>
<td>Alt + F4</td>
<td>Exit PowerDirector</td>
</tr>
</tbody>
</table>

## Project Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + N</td>
<td>Create new project</td>
</tr>
<tr>
<td>Ctrl + O</td>
<td>Open existing project</td>
</tr>
<tr>
<td>Alt + Enter</td>
<td>Display project properties</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Save project</td>
</tr>
<tr>
<td>Ctrl + Shift + S</td>
<td>Save project as</td>
</tr>
<tr>
<td>Ctrl + Shift + W</td>
<td>New Workspace</td>
</tr>
</tbody>
</table>
### Workspace Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Switch between Timeline/Storyboard</td>
</tr>
<tr>
<td>Home</td>
<td>Go to the beginning of clip/project</td>
</tr>
<tr>
<td>End</td>
<td>Go to the end of clip/project</td>
</tr>
<tr>
<td>Alt+1</td>
<td>Opens the Magic Clean function</td>
</tr>
<tr>
<td>Alt+2</td>
<td>Opens the Magic Motion function</td>
</tr>
<tr>
<td>Alt+3</td>
<td>Opens the Magic Cut function</td>
</tr>
<tr>
<td>Alt+4</td>
<td>Opens the Magic Fix function</td>
</tr>
<tr>
<td>Alt+5</td>
<td>Opens the Magic Style function</td>
</tr>
<tr>
<td>Alt+6</td>
<td>Opens the Magic Music function</td>
</tr>
<tr>
<td>Ctrl + right arrow</td>
<td>Go to next clip in the track (Clip mode)</td>
</tr>
<tr>
<td>Ctrl + left arrow</td>
<td>Go to previous clip in the track (Clip mode)</td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Copy</td>
</tr>
<tr>
<td>Ctrl + X</td>
<td>Cut</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Paste</td>
</tr>
<tr>
<td>+</td>
<td>Zoom ruler In</td>
</tr>
<tr>
<td>-</td>
<td>Zoom ruler out</td>
</tr>
</tbody>
</table>
### Menu Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt + L</td>
<td>Lock all tracks except Master Video track</td>
</tr>
<tr>
<td>Alt + U</td>
<td>Unlock all tracks</td>
</tr>
<tr>
<td>Alt + C</td>
<td>Open Preferences</td>
</tr>
</tbody>
</table>

### Smart Guide Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + Alt + T</td>
<td>Display Trim options</td>
</tr>
<tr>
<td>Ctrl + Alt + S</td>
<td>Display Speed options</td>
</tr>
<tr>
<td>Ctrl + Alt + C</td>
<td>Display Color options</td>
</tr>
</tbody>
</table>
### Settings Panel Hotkey

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + Alt + M</td>
<td>Display Multi Trim options</td>
</tr>
<tr>
<td>F2</td>
<td>Display PiP Modification Options/Title Designer/Effect Modification Options</td>
</tr>
</tbody>
</table>

### Main Panel Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Help</td>
</tr>
<tr>
<td>Ctrl + + (plus)</td>
<td>Increase volume</td>
</tr>
<tr>
<td>Ctrl + - (minus)</td>
<td>Decrease volume</td>
</tr>
<tr>
<td>Ctrl + Backspace</td>
<td>Mute/unmute</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete selected item(s)</td>
</tr>
<tr>
<td>Ctrl + Z</td>
<td>Undo</td>
</tr>
<tr>
<td>Ctrl + Y</td>
<td>Redo</td>
</tr>
<tr>
<td>Shift + F12</td>
<td>Show Hotkey list help</td>
</tr>
<tr>
<td>F9</td>
<td>Switch to Capture mode</td>
</tr>
<tr>
<td>Hotkey</td>
<td>Function</td>
</tr>
<tr>
<td>--------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>F10</td>
<td>Switch to Edit mode</td>
</tr>
<tr>
<td>F11</td>
<td>Switch to Produce mode</td>
</tr>
<tr>
<td>F12</td>
<td>Switch to Create Disc mode</td>
</tr>
</tbody>
</table>
## Library Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F5</td>
<td>Open Media Room</td>
</tr>
<tr>
<td>F6</td>
<td>Open Effect Room</td>
</tr>
<tr>
<td>F7</td>
<td>Open Title Room</td>
</tr>
<tr>
<td>F8</td>
<td>Open Transition Room</td>
</tr>
<tr>
<td>Shift + F9</td>
<td>Open Audio Mixing Room</td>
</tr>
<tr>
<td>Shift + F10</td>
<td>Open Voice-Over Recording Room</td>
</tr>
<tr>
<td>Shift + F11</td>
<td>Open Chapter-Setting Room</td>
</tr>
<tr>
<td>Ctrl + Enter</td>
<td>Display media in Media Viewer</td>
</tr>
<tr>
<td>Ctrl + A</td>
<td>Select all</td>
</tr>
<tr>
<td>Ctrl + Tab</td>
<td>Switch between filters</td>
</tr>
<tr>
<td>Ctrl + D</td>
<td>Detect scenes</td>
</tr>
<tr>
<td>Ctrl + Q</td>
<td>Import media file(s)</td>
</tr>
<tr>
<td>Ctrl + W</td>
<td>Import a media folder</td>
</tr>
</tbody>
</table>
### Capture Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + R</td>
<td>Record</td>
</tr>
<tr>
<td>Alt + R</td>
<td>Start recording</td>
</tr>
<tr>
<td>Ctrl + /</td>
<td>Stop recording</td>
</tr>
<tr>
<td>Space bar</td>
<td>DV play/pause</td>
</tr>
<tr>
<td>Ctrl + , (comma)</td>
<td>DV rewind</td>
</tr>
<tr>
<td>Ctrl + . (period)</td>
<td>DV fast forward</td>
</tr>
<tr>
<td>Ctrl + /</td>
<td>DV stop</td>
</tr>
<tr>
<td>Alt + Y</td>
<td>Add text captions on captured video</td>
</tr>
</tbody>
</table>

### Voice-Over Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + H</td>
<td>Fade in</td>
</tr>
<tr>
<td>Ctrl + J</td>
<td>Fade out</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Start recording</td>
</tr>
<tr>
<td>Ctrl + /</td>
<td>Stop recording</td>
</tr>
</tbody>
</table>
## Preview Window Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>Play/pause</td>
</tr>
<tr>
<td>Ctrl + /</td>
<td>Stop</td>
</tr>
<tr>
<td>, (comma)</td>
<td>Previous frame</td>
</tr>
<tr>
<td>. (period)</td>
<td>Next frame</td>
</tr>
<tr>
<td>Page Up</td>
<td>Skip 1 second backward</td>
</tr>
<tr>
<td>Page Down</td>
<td>Skip 1 second forward</td>
</tr>
<tr>
<td>Ctrl+F</td>
<td>Fast forward</td>
</tr>
<tr>
<td>[</td>
<td>Mark in</td>
</tr>
<tr>
<td>]</td>
<td>Mark out</td>
</tr>
<tr>
<td>Ctrl + T</td>
<td>Split</td>
</tr>
<tr>
<td>Ctrl + G</td>
<td>Goto timecode</td>
</tr>
<tr>
<td>Ctrl + E</td>
<td>Display Precise Cut trimmer (when enabled)</td>
</tr>
<tr>
<td>F3</td>
<td>Switch to Movie mode</td>
</tr>
<tr>
<td>F4</td>
<td>Switch to Clip mode</td>
</tr>
<tr>
<td>Ctrl + Enter</td>
<td>Display media in Media Viewer</td>
</tr>
<tr>
<td>Ctrl + U</td>
<td>Adjust system volume</td>
</tr>
</tbody>
</table>
Title Designer Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + B</td>
<td>Set text in bold</td>
</tr>
<tr>
<td>Ctrl + I</td>
<td>Set text in italics</td>
</tr>
<tr>
<td>Ctrl + L</td>
<td>Left-align text</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Right-align text</td>
</tr>
<tr>
<td>Ctrl + E</td>
<td>Center-align text</td>
</tr>
<tr>
<td>Ctrl + T</td>
<td>Show/hide TV Safe lines</td>
</tr>
<tr>
<td>Ctrl + G</td>
<td>Show/hide Gridlines</td>
</tr>
</tbody>
</table>

PiP Designer Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + T</td>
<td>Show/hide TV Safe lines</td>
</tr>
<tr>
<td>Ctrl + G</td>
<td>Show/hide Gridlines</td>
</tr>
</tbody>
</table>
FAQ

Answers to the most frequently asked questions concerning CyberLink PowerDirector are listed below. If you require further information, see Technical Support on p.194.

1. What's new in PowerDirector?

New Features:

- **Magic Style** automatically creates exciting movies with visual effects, transitions, titles, and PiP effects for users.
- **Magic Fix** stabilizes shaky videos and enhances the focus on blurry photos.
- **Magic Clean** instantly corrects color temperature, making your video clip clearer, sharper and brighter.
- **Preview Timeline** by tracks can hide timeline tracks from view to let users focus on the track they are working on.
- **Adjustable Preview Quality** lets users choose between a high quality preview or a fast preview.
- **Smart Captions** for DV/TV captures let users insert time code, date code, or remarks into their captured videos.
- **Widescreen Support** allows users to capture and produce true 16:9 widescreen videos and movies.
- **Integrated Authoring** in Create Disc mode lets users produce and create DVD movies on-the-fly.

Improved Features:

- Video effects, title effects, and transition effects
- Enhanced features in Magic Tools
- Enhanced control in Title Designer
- HDV Support
- New Video format support for HD video, AVC-MPEG4, and Sony Memory Stick Video Format (PSP)
2. **How do I know if my DVD player will play the DVDs I create with PowerDirector?**

Movie titles/discs created by PowerDirector have been thoroughly tested in the Class A verification lab approved by the DVD Forum. This means we are being verified and tested in world class labs that guarantee our compatibility. A DVD player that carries a DVD-video compatible logo should playback any movie discs without any problems.

3. **What file formats can be imported by PowerDirector?**

   - **Video**: .avi, .dat, .mpe, .mpg, .mpeg, DivX (requires codec), .wmv
   - **Audio**: .mp3, .wav, .wma, .asf
   - **Photo**: .bmp, .gif, .jpe, .jpeg, .jpg, .png, .tif, .tiff

4. **What movie disc types can be produced by PowerDirector?**

   - DVD, DVD folders and disc images
   - SVCD/VCD

5. **What is SVRT/SVRT II and when can I use it?**

SVRT (Smart Video Rendering Technology) is a proprietary rendering technology from CyberLink that intelligently recognizes which portions of a movie clip have been modified, and only renders those portions - not the entire video clip - during production. Rendering only the modified portions of a video clip saves time and preserves the original quality of the video. Using SVRT, PowerDirector renders MPEG-1, MPEG-2, and DV-AVI video faster than any other software on the market. (Other video editing software programs have to render the entire video even if one single frame has been modified!)

   SVRT II further breaks movie clips into their component video and audio parts, then renders only the audio or video portion
that has been modified. This further reduces the amount of time needed for production!

CyberLink’s Smart Video Rendering Technology is available during production when the frame rate, frame size, and file format of video files in your movie are the same (and bitrate is similar). In this case, SVRT is used to render these files. If any clips do not meet the above criteria, they are fully rendered without SVRT.

If you have previously produced a disc using SVRT and the disc encountered compatibility issues with your player, render the video again without using SVRT. (Some players are unable to play back MPEG video with a modified GOP pattern.)

6. **What is “editable DVD”?**

Editable DVD is to make your authored DVD able to be further edited even when it’s already burn on a disc. By applying this technology, you will be able to record your DVD quickly and you will also be able to append new videos, change backgrounds later when you finished it. Editable DVD is 100% compatible with your DVD player.

7. **How do I know if my hardware is compatible with or supported by PowerDirector?**

Check out the hardware approval sheet in the readme file. An updated version can also be found on CyberLink’s website.

8. **Which languages does PowerDirector support?**

PowerDirector supports the languages listed below:
- Chinese, Simplified
- Chinese, Traditional
- English
- French
9. Commercial DVDs often contain up to 3 hours of video. How can I use PowerDirector to make a DVD that long?

Change the video quality setting in the Create Disc Preference window of Create Disc mode. When you select a video quality, the detailed attributes of that quality setting are displayed in the Summary window of Create Disc mode. For more information, see Video Qualities on p.216.

10. Isn't MPEG encoding slow? How does PowerDirector increase production speed?

Using SVRT, PowerDirector only renders the modified part of a video sequence, without rendering the untouched parts. This speeds up production time considerably. SVRT is the smartest way to render MPEG and still retain the original video quality.
SVRT2: When Can I Use it?

SVRT2 can be applied to video clips in the MPEG-1, MPEG-2, and DV-AVI (Type I) formats. In the following conditions, clips (or portions of clips) do not require rendering during production, and SVRT2 can therefore be applied:

- The frame rate, frame size, and file format are the same as those of the destination production profile.
- The bitrate is similar to that of the destination production profile.
- The TV format is the same as that of the destination production profile. For more information, see Set a Video Clip’s Interlacing Format on p.92.

If all of the above conditions are met, SVRT2 can be used. Any clips that do not meet the above criteria are fully rendered without SVRT2.

In the following conditions, clips (or portions of clips) must be rendered during production, and SVRT2 can therefore not be applied:

- Adding a title or transition effect
- Modifying the color of a video clip
- Audio profile does not match destination production profile
- Modifying the volume of an audio clip
- Merging two video clips (clips within 2 seconds before or after the merged clips will be rendered)
- Splitting a video clip (clips within 2 seconds before or after the split will be rendered)
- Trimming a video clip (clips within 2 seconds before or after the trimmed clip will be rendered)
Disc Types & Formats

This section describes the different disc types and disc formats that you can use in CyberLink PowerDirector.

Disc Types

In broad terms, discs are divided into CD (which, being the earlier technology, is more widely supported) and DVD (which holds many times the amount of content, but requires a different drive). Following is a brief description of the different disc types supported by CyberLink PowerDirector.

Multisession Discs

Multisession discs allow you to append additional data after the original burning session. PowerDirector creates a multisession disc whenever you burn a CD-R, CD-RW, DVD-R, or DVD+R disc and choose not to close or finalize the disc. Therefore, you can continue to add content to a multisession disc until the disc is full or closed, at which point you can no longer append any further data.

CD Types

CDs contain up to 74/80 minutes of high quality video or 650/700 MB of data.

<table>
<thead>
<tr>
<th>CD Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD-R</td>
<td>CD-R is a “write once” CD format. CD-RW burners and most new DVD burners can write in CD-R, and most DVD players can also read this format.</td>
</tr>
<tr>
<td>CD-RW</td>
<td>CD-RW is an erasable CD format. CD-RW burners and most new DVD burners can write in CD-RW, and most DVD players can also read this format.</td>
</tr>
</tbody>
</table>
DVD Types

DVD is a high capacity disc that holds anywhere from 4.7-17 GB of data, or from roughly 2-8 hours of video (depending on the type of DVD and the video quality setting). Using the High Quality setting, you can expect to be able to record 1-2 hours of video.

DVDs can be played on DVD players and computers equipped with DVD drives. For more detailed information on DVD-R/RW formats, see www.dvdrhelp.com/dvd or other web sources. For more detailed information on DVD+R/RW formats, see www.dvdrw.com or other web sources.

<table>
<thead>
<tr>
<th>DVD Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVD-R</td>
<td>DVD-R, a “write once” DVD format, is a competitor product to DVD+R, and is therefore not compatible with that format. Some new DVD burners can write in both DVD-R and DVD+R, and most DVD players can read both formats.</td>
</tr>
<tr>
<td>DVD-RW</td>
<td>DVD-RW, an erasable DVD format, is a competitor product to DVD+RW, and is therefore not compatible with that format. Some new DVD burners can write in both DVD-RW and DVD+RW, and most DVD players can read both formats.</td>
</tr>
<tr>
<td>DVD+R</td>
<td>DVD+R, a “write once” DVD format, is a competitor product to DVD-R, and is therefore not compatible with that format. Some new DVD burners can write in both DVD-R and DVD+R, and most DVD players can read both formats.</td>
</tr>
<tr>
<td>DVD+RW</td>
<td>DVD+RW, an erasable DVD format, is a competitor product to DVD-RW, and is therefore not compatible with that format. Some new DVD burners can write in both DVD-RW and DVD+RW, and most DVD players can read both formats.</td>
</tr>
</tbody>
</table>
### Disc Formats

Below is a description of the formats that CyberLink PowerDirector supports for burning discs:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DivX</td>
<td>DivX is a video file format based on MPEG-4 technology. DivX creates a very small video that can be attached in an email, played back on a media player, viewed on a TV, or written to VHS tape. The DivX codec can be downloaded for free from the DivX website at <a href="http://www.divx.com/divx/">www.divx.com/divx/</a></td>
</tr>
<tr>
<td>DVD-Video</td>
<td>DVD-Video is the most widely supported DVD movie format, which can be played on almost all DVD players.</td>
</tr>
<tr>
<td>DVD-VR</td>
<td>A video format on DVD-RW or DVD-RAM discs. DVD-VR discs can be played on a DVD player with the RW Compatible logo.</td>
</tr>
<tr>
<td>DVD+VR</td>
<td>A video format on DVD+R/RW, DVD-R/RW discs. DVD+VR discs can be played on a DVD-Video player.</td>
</tr>
</tbody>
</table>
SVCD (Super Video Compact Disc) is a CD video format that uses MPEG compression. SVCD offers much higher video quality than VCD. It can hold 35 minutes of video, and can contain menus and chapters like a DVD, as well as slide shows with background audio. SVCDs can be played on a PC with DVD playback software, and on some standalone DVD players.

VCD (video compact disc) is a CD video format that uses MPEG compression. VCD contains audio and video of a quality about the same as that of VHS, and also contains menus and chapters like a DVD. VCD can be played on a PC with VCD/MPEG playback software and on most stand-alone DVD players.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVCD</td>
<td>SVCD (Super Video Compact Disc) is a CD video format that uses MPEG compression. SVCD offers much higher video quality than VCD. It can hold 35 minutes of video, and can contain menus and chapters like a DVD, as well as slide shows with background audio. SVCDs can be played on a PC with DVD playback software, and on some standalone DVD players.</td>
</tr>
<tr>
<td>VCD</td>
<td>VCD (video compact disc) is a CD video format that uses MPEG compression. VCD contains audio and video of a quality about the same as that of VHS, and also contains menus and chapters like a DVD. VCD can be played on a PC with VCD/MPEG playback software and on most stand-alone DVD players.</td>
</tr>
</tbody>
</table>
Disc Type/Format Compatibility

Since some commercial CD players cannot play CD-RWs, it is recommended that you use CD-R/CD+R discs to burn music CDs.

It is recommended that you use DVD-RW or DVD-RAM discs for video in DVD-VR format. DVD-VR discs can be played on a DVD player with the -VR Compatible logo.

It is recommended that you use DVD+R/RW or DVD-R/RW discs for video in DVD+VR format. DVD+VR discs can be played on a DVD-Video player.
Video Formats & Qualities

When you burn video to disc, you must take into consideration not only the quality you want to use, but also the TV format of the country or region in which you want to watch the movie disc you burn. The section below offers information on both of these topics, allowing you to burn video discs that suit your playback capabilities.

TV Formats

The two TV formats (NTSC and PAL) have been adopted as standards by television broadcasters around the world. The main difference between the two formats is the number of frames per second they offer: 30 in NTSC, and 25 in PAL. This difference means that a movie recorded in NTSC format is unplayable by a PAL player and vice versa.

Fortunately, the question of whether to use PAL or NTSC television format for your disc can be reduced to the following simple question:

- **In which country or region do you plan to play this disc?**

Since all countries use either the NTSC or PAL format, knowing the location in which the disc will be played pretty much resolves this issue for you. By selecting the desired country or region, the television format is automatically set.

**Note:** Generally speaking, the United States, Japan, Canada, and Mexico use NTSC, while Germany, Great Britain, South America, Australia, and most of Western European and Asian countries use PAL.
Video Qualities

The different video quality settings (HQ, SP, and LP) available in CyberLink PowerDirector result in a final picture of higher or lower quality and a movie file of larger or smaller size. Better quality video also demands more from your computer and limits the video duration you can burn to disc. Below is a comparison of the length of video you can expect to be able to burn to a DVD using the different qualities:

- **HQ**: 60 minutes
- **SP**: 120 minutes
- **LP**: 180 minutes

For the best possible image quality in your final production, select the highest video quality that will allow your production to fit onto the disc type you are using. Your ultimate choice of video quality, however, should be based both on the image quality you want in your final production and on the processing power of your computer.
## Glossary

The glossary provides definitions of terms used in this user’s guide that you may find unfamiliar.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>chapter</td>
<td>A marker set in a video clip in order allow viewers to jump to that specific point for navigation purposes.</td>
</tr>
<tr>
<td>clip</td>
<td>A video, audio, or image file that has been loaded into PowerDirector’s Library for use in your movie.</td>
</tr>
<tr>
<td>color filter</td>
<td>An option in PiP effects that makes a selected color transparent, allowing the underlying clip to show through in the transparent areas.</td>
</tr>
<tr>
<td>deinterlacing</td>
<td>Methods used to reduce or eliminate the decrease in video quality caused by interlacing.</td>
</tr>
<tr>
<td>DV</td>
<td>(Digital Video) Refers to the capturing, manipulation and storage of video in digital formats. The DV format is an international standard for consumer use created in 1995 by a consortium of companies.</td>
</tr>
<tr>
<td>DVD folder</td>
<td>A folder containing all of the media files for your production that can be burned to a disc for storage.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>GOP pattern</strong></td>
<td>(Group of Pictures pattern) A pattern in MPEG encoding made up of groups of pictures (consisting of I-, B-, and P-frames), which have certain dependent relationships during encoding. Changes to this pattern can cause playback errors in some players.</td>
</tr>
<tr>
<td><strong>HDV</strong></td>
<td>HDV or High Definition Video refers to the capturing, manipulation and storage of high definition video in standard digital formats. The HDV format is an international standard for consumer use created in 2003 by a consortium of companies.</td>
</tr>
<tr>
<td><strong>hold time</strong></td>
<td>Used to describe the time a moving effect (PiP or title effect) remains stationary on the screen.</td>
</tr>
<tr>
<td><strong>HQ</strong></td>
<td>(High Quality) The highest video quality you may select in PowerDirector.</td>
</tr>
<tr>
<td><strong>hue</strong></td>
<td>The attribute of a color that distinguishes it from other colors.</td>
</tr>
<tr>
<td><strong>interlacing</strong></td>
<td>Flickering or artefacts caused by the way video signals are broadcast. (Each frame of video is made up of a number of lines. When video frames are broadcast, the odd lines of the screen display are illuminated first, then the even lines. This causes the interlacing problem, which is most evident when the video contains motion.)</td>
</tr>
<tr>
<td><strong>key frame</strong></td>
<td>A key frame is defined as a frame in a video sequence that does not require information from a previous frame for decompression. More key frames yield better video quality but require greater amounts of disk space.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LP</td>
<td>(Long Play) The lowest video quality you may select in PowerDirector.</td>
</tr>
<tr>
<td>menu</td>
<td>A page on a DVD that contains links to the chapters the DVD contains.</td>
</tr>
<tr>
<td>MPEG</td>
<td>(Moving Picture Experts Group) A family of international standards used for coding audio/video information into digital format. Currently, MPEG-2 is the standard for digital video formats and MP3 for strictly digital audio formats.</td>
</tr>
<tr>
<td>non-realtime capture</td>
<td>Non-realtime capture continues processing video after the video capture playback stops in order to ensure that no frames are dropped. Capturing video at a higher speed reduces processing time, but yields video of a lower quality. Capturing better quality video requires more CPU power and more time to complete.</td>
</tr>
<tr>
<td>NTSC</td>
<td>(National Television Systems Committee) A standard format adopted by the FCC for television broadcasts in the United States, Japan, Canada, and Mexico. NTSC offers 525 lines of resolution per frame at 30 fps.</td>
</tr>
<tr>
<td>PAL</td>
<td>(Phase Alteration Line) The standard format for television broadcasts in Germany, Great Britain, South America, Australia, and most of Western European and Asian countries. PAL offers 25 frames per second.</td>
</tr>
</tbody>
</table>
### Term | Description
---|---
realtime capture | Realtime capture completes capturing during playback of the original video. Realtime capture requires high processing speeds and risks dropped frames.
saturation | The richness of a color.
slide | An individual photo within a slide show. Slides are contained within albums.
slide show | A presentation that can include both photos (called slides) and effects, such as transitions and background music. The photos and effects in a slide show are contained in units called albums, which can contain any number of photos, as well as transitions and music.
SP | (Standard Play) The median video quality in PowerDirector, inferior to HQ but superior to LP.
streaming | Streaming is a data transfer technology that allows viewers to play a file received over the Internet without downloading it onto their own computer.
SVRT, SVRT II | (Smart Video Rendering Technology) A proprietary movie rendering technology from CyberLink that only compiles those portions of a movie clip that have been modified, reducing the amount of time needed for production. SVRT II is able to discern between audio and video portions of a movie clip, and only renders the portion that has been modified. For a fuller discussion of SVRT/SVRT II, see What is SVRT/SVRT II and when can I use it? on p.206.
<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type I</td>
<td>Method of storing DV data in AVI format that was defined by Microsoft. This format stores data (i.e. video and audio) as a single AVI stream. It offers better compression, but is newer, and therefore compatible with fewer systems than Type II.</td>
</tr>
<tr>
<td>Type II</td>
<td>Method of storing DV data in AVI format that was defined by Microsoft. This format stores data (i.e. video and audio) as a single video stream and 1-4 audio streams to store DV data. It offers wider compatibility, but uses an older compression than Type I. This format requires slightly more processing time to split the video/audio stream while capturing.</td>
</tr>
<tr>
<td>volume key</td>
<td>A point you can set within an audio track in order to increase or decrease volume beginning at that point.</td>
</tr>
<tr>
<td>WMV</td>
<td>(Windows Media Audio) A Windows streaming audio format used for files destined to be downloaded or played over the Internet.</td>
</tr>
</tbody>
</table>

Appendix
Licensing and Copyright Notices

This document contains the PowerDirector licensing and copyright information, including a copy of the Intel License Agreement for Open Source Computer Library, the GNU Lesser General Public License, and the Dolby Laboratories copyright information. There is also a list of the third-party components used in PowerDirector.
License Disclaimer

This product includes certain copyrighted third-party software components license under the terms of the GNU Lesser General Public License and other similar license agreements offering free distribution of these software components offered by other organizations, if applicable. Copies of these agreements can be found by clicking the link associated with each of the component provided in the table below. You may also visit http://www.gnu.org/copyleft/lesser.html for a copy of GNU Lesser General Public License Agreement.

LGPL components and other components listed below are licensed without warranties of any kind, either express or implied warranties, including without limitation the implied warranties of merchantability and fitness for a particular purpose. The entire risk as the quality and performance of these components is with you. Please check the respective license agreement for more details.

Copyright Holders under LGPL and/or other license agreements mentioned herein shall not be responsible for any damages, general, special, incidental or consequential, arising out of the use or inability to use these components/software. Please check the respective license agreement for more details.

For a list of components of such nature, and to acquire the full source code of these licensed components, including any scripts to control compilation and installation of the object code, please see "List of Components" below.

Downloading Source Code

You can download the machine-readable source code of the corresponding licensed component from http://www.cyberlink.com/. Please read the copyright notice, the warranty disclaimer, and the license agreement accompanying these source codes.
## List of Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Licensing Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>cv.dll</td>
<td>Intel License Agreement for Open Source Computer Library</td>
</tr>
<tr>
<td>cvaux.dll</td>
<td>Intel License Agreement for Open Source Computer Library</td>
</tr>
<tr>
<td>highgui.dll</td>
<td>Intel License Agreement for Open Source Computer Library</td>
</tr>
<tr>
<td>OptCVa6.dll</td>
<td>Intel License Agreement for Open Source Computer Library</td>
</tr>
<tr>
<td>OptCVm6.dll</td>
<td>Intel License Agreement for Open Source Computer Library</td>
</tr>
<tr>
<td>OptCVw7.dll</td>
<td>Intel License Agreement for Open Source Computer Library</td>
</tr>
<tr>
<td>PThreadVC2.dll</td>
<td>GNU Lesser General Public License</td>
</tr>
</tbody>
</table>


Licenses and Copyrights

Below are the applicable licenses and copyright information that pertain to the components listed in the List of Components.

Dolby Laboratories

Manufactured under license from Dolby Laboratories. “Dolby”, and the double-D symbol are trademarks of Dolby Laboratories. Confidential unpublished works. Copyright 1992-1997 Dolby Laboratories. All rights reserved.

Intel License Agreement For Open Source Computer Vision Library

Copyright © 2000, Intel Corporation, all rights reserved. Third party copyrights are property of their respective owners.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

Redistribution's of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

Redistribution's in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

The name of Intel Corporation may not be used to endorse or promote products derived from this software without specific prior written permission.
This software is provided by the copyright holders and contributors “as is” and any express or implied warranties, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose are disclaimed. In no event shall Intel or contributors be liable for any direct, indirect, incidental, special, exemplary, or consequential damages (including, but not limited to, procurement of substitute goods or services; loss of use, data, or profits; or business interruption) however caused and on any theory of liability, whether in contract, strict liability, or tort (including negligence or otherwise) arising in any way out of the use of this software, even if advised of the possibility of such damage.

GNU Lesser General Public License

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc.

51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts as the successor of the GNU Library Public License, version 2, hence the version number 2.1.]

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General Public Licenses are intended to guarantee your freedom to share and change free software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some specially designated software packages--typically libraries--of the Free Software Foundation and other authors who decide to use it. You can use it too, but we suggest you first think carefully about whether this license or the ordinary General Public License is the
better strategy to use in any particular case, based on the explanations below.

When we speak of free software, we are referring to freedom of use, not price. Our General Public Licenses are designed to make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish); that you receive source code or can get it if you want it; that you can change the software and use pieces of it in new free programs; and that you are informed that you can do these things.

To protect your rights, we need to make restrictions that forbid distributors to deny you these rights or to ask you to surrender these rights. These restrictions translate to certain responsibilities for you if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must give the recipients all the rights that we gave you. You must make sure that they, too, receive or can get the source code. If you link other code with the library, you must provide complete object files to the recipients, so that they can relink them with the library after making changes to the library and recompiling it. And you must show them these terms so they know their rights.

We protect your rights with a two-step method: (1) we copyright the library, and (2) we offer you this license, which gives you legal permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there is no warranty for the free library. Also, if the library is modified by someone else and passed on, the recipients should know that what they have is not the original version, so that the original author’s reputation will not be affected by problems that might be introduced by others.

Finally, software patents pose a constant threat to the existence of any free program. We wish to make sure that a company cannot effectively restrict the users of a free program by obtaining a restrictive license from a patent holder. Therefore, we insist that any
patent license obtained for a version of the library must be consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the ordinary GNU General Public License. This license, the GNU Lesser General Public License, applies to certain designated libraries, and is quite different from the ordinary General Public License. We use this license for certain libraries in order to permit linking those libraries into non-free programs.

When a program is linked with a library, whether statically or using a shared library, the combination of the two is legally speaking a combined work, a derivative of the original library. The ordinary General Public License therefore permits such linking only if the entire combination fits its criteria of freedom. The Lesser General Public License permits more lax criteria for linking other code with the library.

We call this license the "Lesser" General Public License because it does Less to protect the user’s freedom than the ordinary General Public License. It also provides other free software developers Less of an advantage over competing non-free programs. These disadvantages are the reason we use the ordinary General Public License for many libraries. However, the Lesser license provides advantages in certain special circumstances.

For example, on rare occasions, there may be a special need to encourage the widest possible use of a certain library, so that it becomes a de-facto standard. To achieve this, non-free programs must be allowed to use the library. A more frequent case is that a free library does the same job as widely used non-free libraries. In this case, there is little to gain by limiting the free library to free software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free programs enables a greater number of people to use a large body of free software. For example, permission to use the GNU C Library in non-free programs enables many more people to use the whole GNU operating system, as well as its variant, the GNU/Linux operating system.
Although the Lesser General Public License is less protective of the users' freedom, it does ensure that the user of a program that is linked with the Library has the freedom and the wherewithal to run that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and modification follow. Pay close attention to the difference between a "work based on the library" and a "work that uses the library". The former contains code derived from the library, whereas the latter must be combined with the library in order to run.

**TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION**

0. This License Agreement applies to any software library or other program which contains a notice placed by the copyright holder or other authorized party saying it may be distributed under the terms of this Lesser General Public License (also called "this License"). Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data prepared so as to be conveniently linked with application programs (which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work which has been distributed under these terms. A "work based on the Library" means either the Library or any derivative work under copyright law: that is to say, a work containing the Library or a portion of it, either verbatim or with modifications and/or translated straightforwardly into another language. (Hereinafter, translation is included without limitation in the term "modification".)

"Source code" for a work means the preferred form of the work for making modifications to it. For a library, complete source code means all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used to control compilation and installation of the library.

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of running a program using the Library is not restricted, and output from such a
program is covered only if its contents constitute a work based on the Library (independent of the use of the Library in a tool for writing it). Whether that is true depends on what the Library does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library’s complete source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and distribute a copy of this License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the Library, and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:

a) The modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices stating that you changed the files and the date of any change.

c) You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this License.

d) If a facility in the modified Library refers to a function or a table of data to be supplied by an application program that uses the facility, other than as an argument passed when the facility is invoked, then you must make a good faith effort to ensure that, in the event an application does not supply such function or table, the facility still operates, and performs whatever part of its purpose remains meaningful.

(For example, a function in a library to compute square roots has a purpose that is entirely well-defined independent of the application. Therefore, Subsection 2d requires that any application-supplied function or table used by this function must be optional: if the
application does not supply it, the square root function must still compute square roots.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Library, and can be reasonably considered independent and separate works in themselves, then this License, and its terms, do not apply to those sections when you distribute them as separate works. But when you distribute the same sections as part of a whole which is a work based on the Library, the distribution of the whole must be on the terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to exercise the right to control the distribution of derivative or collective works based on the Library.

In addition, mere aggregation of another work not based on the Library with the Library (or with a work based on the Library) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given copy of the Library. To do this, you must alter all the notices that refer to this License, so that they refer to the ordinary GNU General Public License, version 2, instead of to this License. (If a newer version than version 2 of the ordinary GNU General Public License has appeared, then you can specify that version instead if you wish.) Do not make any other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General Public License applies to all subsequent copies and derivative works made from that copy.

This option is useful when you wish to copy part of the code of the Library into a program that is not a library.
4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or executable form under the terms of Sections 1 and 2 above provided that you accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange.

If distribution of object code is made by offering access to copy from a designated place, then offering equivalent access to copy the source code from the same place satisfies the requirement to distribute the source code, even though third parties are not compelled to copy the source along with the object code.

5. A program that contains no derivative of any portion of the Library, but is designed to work with the Library by being compiled or linked with it, is called a "work that uses the Library". Such a work, in isolation, is not a derivative work of the Library, and therefore falls outside the scope of this License.

However, linking a "work that uses the Library" with the Library creates an executable that is a derivative of the Library (because it contains portions of the Library), rather than a "work that uses the library". The executable is therefore covered by this License. Section 6 states terms for distribution of such executables.

When a "work that uses the Library" uses material from a header file that is part of the Library, the object code for the work may be a derivative work of the Library even though the source code is not. Whether this is true is especially significant if the work can be linked without the Library, or if the work is itself a library. The threshold for this to be true is not precisely defined by law.

If such an object file uses only numerical parameters, data structure layouts and accessors, and small macros and small inline functions (ten lines or less in length), then the use of the object file is unrestricted, regardless of whether it is legally a derivative work. (Executables containing this object code plus portions of the Library will still fall under Section 6.)
Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work under the terms of Section 6. Any executables containing that work also fall under Section 6, whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link a "work that uses the Library" with the Library to produce a work containing portions of the Library, and distribute that work under terms of your choice, provided that the terms permit modification of the work for the customer's own use and reverse engineering for debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it and that the Library and its use are covered by this License. You must supply a copy of this License. If the work during execution displays copyright notices, you must include the copyright notice for the Library among them, as well as a reference directing the user to the copy of this License.

Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-readable source code for the Library including whatever changes were used in the work (which must be distributed under Sections 1 and 2 above); and, if the work is an executable linked with the Library, with the complete machine-readable "work that uses the Library", as object code and/or source code, so that the user can modify the Library and then relink to produce a modified executable containing the modified Library. (It is understood that the user who changes the contents of definitions files in the Library will not necessarily be able to recompile the application to use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (1) uses at run time a copy of the library already present on the user's computer system, rather than copying library functions into the executable, and (2) will operate properly with a modified version of the library, if the user installs one, as long as the modified version is interface-compatible with the version that the work was made with.
c) Accompany the work with a written offer, valid for at least three years, to give the same user the materials specified in Subsection 6a, above, for a charge no more than the cost of performing this distribution.

d) If distribution of the work is made by offering access to copy from a designated place, offer equivalent access to copy the above specified materials from the same place.

e) Verify that the user has already received a copy of these materials or that you have already sent this user a copy.

For an executable, the required form of the "work that uses the Library" must include any data and utility programs needed for reproducing the executable from it. However, as a special exception, the materials to be distributed need not include anything that is normally distributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies the executable.

It may happen that this requirement contradicts the license restrictions of other proprietary libraries that do not normally accompany the operating system. Such a contradiction means you cannot use both them and the Library together in an executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in a single library together with other library facilities not covered by this License, and distribute such a combined library, provided that the separate distribution of the work based on the Library and of the other library facilities is otherwise permitted, and provided that you do these two things:

a) Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library facilities. This must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and explaining where to find the accompanying uncombined form of the same work.
8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under this License. Any attempt otherwise to copy, modify, sublicense, link with, or distribute the Library is void, and will automatically terminate your rights under this License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or distribute the Library or its derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by modifying or distributing the Library (or any work based on the Library), you indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives a license from the original licensor to copy, distribute, link with or modify the Library subject to these terms and conditions. You may not impose any further restrictions on the recipients' exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not distribute the Library at all. For example, if a patent license would not permit royalty-free redistribution of the Library by all those who receive copies directly or indirectly through you, then the only way you could satisfy both it and this License would be to refrain entirely from distribution of the Library.
If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is intended to apply, and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution system which is implemented by public license practices. Many people have made generous contributions to the wide range of software distributed through that system in reliance on consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted interfaces, the original copyright holder who places the Library under this License may add an explicit geographical distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus excluded. In such case, this License incorporates the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new versions of the Lesser General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library specifies a version number of this License which applies to it and "any later version", you have the option of following the terms and conditions either of that version or of any later version published by the Free Software Foundation. If the Library does not specify a license version number, you may choose any version ever published by the Free Software Foundation.
14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions are incompatible with these, write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
CLAPACK Copyright Notice

adding
  audio clips to workspace 71
  clips to workspace 69
  color boards to workspace 70
  images to workspace 69
  title effects to Timeline 72
  transition effects to Timeline 72
  video effects to Timeline 71
aliases 61
align clips in Timeline 74
analog video capture options 20
animations
  in title effects 134, 135
aspect ratio
  adjusting 93
  setting 54
audio
  adding clips to the workspace 71
  capture options 21
  compression bitrate 164
  Magic Music 108
Audio Mixer 96
  adding fade effect in 97
  mixing audio in 96
Audio Mixing Room 57
audio types 186
automatic batch capture 27
AVC
  producing files 156
AVI
  producing files 145
  production profiles 160, 162
batch capturing 27
  automatic 27
  manual 31
border in PiP effects 115
Burn to disc 190
burning
  configuration 188
buttons
  frame style 182
  layout 182
  number per page 182
  style 182
capture
  automatic batch 27, 31
  batch 27
  from CD 43
  from Digital TV 38
  from DV device 25
  from HDV device 34
  from microphone 41
  from PC camera 40
  from TV 36
CyberLink PowerDirector 5

from webcam 40
limit options 18
media 15
mode 16
preferences 17
single scene 25
capture options 18
analog video options 20
audio 21
CD 23
deleting captured files 24
detecting scenes 24
fade-ins in 21
fade-outs in 21
limits 18
microphone 23
naming captured files 24
TV 20
webcam 22
captured clip options 23
CD
capture profile setup 23
capturing from 43
types 210
vs. DVD 210
CD+R, use for burning music 214
CD-R
description 210
use for burning music 214
CD-RW
description 210
limitation of 214
Chapter Setting Room 57
chapters
definition 217
setting 76
clear workspace 48
clips
definition 217
previewing in Media Editor 139
previewing in preview window 137
trimming 83
viewing properties in Library 62
CLNR 102
color boards, adding to the workspace 70
color filter, adding to PiP effects 121
color filter, definition 217
compatibility of file formats & disc types 214
copying
clips in workspace 73
hotkey shortcut 197
Create a DVD folder 190
create disc
mode 180
create new project file 48
creating
MPEG production profile 163
customizing
MPEG production profile 163
customizing menu pages 181
cutting
clips in workspace 73
hotkey shortcut 197
CyberLink Noise Reduction 102

D
default
menu style 187
default durations, setting 52
deinterlacing 164
deinterlacing, definition 217
deleting
  a captured file 24
  files from disk 60
detecting scenes
  by changing timecodes 64
  in captured clips 24
  in video clips 63
  setting sensitivity 63
Digital TV
  capturing from 38
disc types
  compatible video formats 214
  supported 206, 210
disc utilities
  erasing 191
DivX
  creating 150
  description 212
  producing 150
  where to download codec 212
download a template 182
dragging
  clips in the workspace 73
  to trim clips 85
  to trim effects 112
duration
  defaults for image files and effects 52
  minimum for batch capture 33
  of capture 18
  of effects 111
  of music clips in Magic Music 109
  of video by quality 216
  of video in Magic Cut 105
  sort by in Library 59
Duration of scenes 105
DV
  camcorder, capturing from 25
  definition 217
  parameters 17
  tape, writing to 175
DV-AVI
  detecting scenes in 63
  interlaced video in 92
  producing 145
DVD
  interlaced video in 92
  types 211
  vs. CD 210
DVD folder, definition 217
DVD+R
  description 211
  use with DVD+VR 214
DVD+RW
  description 211
  use with DVD+VR 214
  use with DVD-VR 214
DVD+VR
  compatible discs 214
  description 212
DVD-R
  description 211
  use with DVD+VR 214
DVD-RAM
  description 212
  use with DVD-VR 214
DVD-RW
  description 211
  use with DVD+VR 214
  use with DVD-VR 214
DVD-Video, description 212
DVD-VR
compatible discs 214
description 212

EagleVision
photos 99, 100
editiable DVD, what is 207
editing
text on disc menus 183
editing preferences 52
Effect Room, description 56
Effect track
adding effects 71
description 66
effects
previewing in Media Editor 139
previewing in preview window 137
setting duration 111
erasing discs 191
eyedropper tool 121

ingeneral preferences 50, 51
generating
AVC files 156
AVI files 145
DivX files 150
MPEG files 152
PSP files 154
RealVideo files 168
WMV files 166
glossary 217
GOP pattern 218

HDV
camcorder, capturing from 34
definition 218
hide a track in the Timeline 66
High Quality 218
high quality 164
High Quality, video duration of 216
high speed 164
hold time
  definition 218
hotkeys 196
hours of technical support 195
HQ 218
  video duration of 216

I

images
  adding to workspace 69
    EagleVision 99, 100
importing media 58
interlacing
  definition 218
  format, setting 92
intervals, scanning for 29
in-track audio mixing 95
introduction 1

K

key frame 218

L

languages supported 207
Library
  aliases in 61
  deleting files from disk in 60
  description 55
  detecting scenes in 63
  importing media into 58
  removing clips from 60
  restricting display in 59
  sorting clips in 59
lock tracks in the Timeline 66
Long Play quality
  definition 219
  video duration of 216
  video duration of 216
LP 219

M

Magic Clean
  audio 102
  images 99
  video 100
Magic Cut 104
Magic Fix 105
  images 106
  videos 105
Magic Motion 103
Magic Music 108
Magic Style 107
manual batch capture 31
master audio level, setting 41
Maximum undo levels, setting 51
Media Editor 138
  previewing effects in 139
  trimming video in 87
Media Room 56
Media Viewer 138
  Instant Preview 80
  previewing in 139
  previewing movie in 80
  Rendering Preview 80
menus
Button Layout 182
Button Style 182
Buttons Per Page 182
customizing 181
editing text 183
first play 184
Frame 182
Template 181
microphone
capture profile setup 23
capturing from 41
mixing
in Audio Mixer 96
in-track 95
modes in PowerDirector 11
modifying disc menu
Button Layout 182
Button Style 182
Buttons Per Page 182
editing text 183
Frame 182
Template 181
modifying effects
PiP 114
title 124
video 113
motion
adding to image clip 103
of PiP effects, modifying 119
movie
previewing in Media Viewer 80
previewing in preview window 79
movie-making process 3
moving clips in workspace 73
MPEG
definition 219
producing files 152
production profiles 163
multisession discs 210
Music track
adding clips 71
description 66
muting
audio tracks 88
entire track 88
naming captured files 24
narration, recording 44
new
features 205
project file 48
workspace 48
noise removal 164
non-realtime capture, definition 219
NTSC 219
countries that use 215
frame rate 215
OEM versions 14
open project file 48
opening
Favorite files 183
Original version window 98
Output version window 98
 PAL 219
  countries that use 215
  frame rate 215
 pan an image 103
 pasting clips in workspace 73
 PC camera, capturing from 40
 photo
  Magic Fix 105
 PhotoNow! 91
 photos
  EagleVision 99, 100
 PiP effects
  adding color filter 121
  modifying border 115
  modifying motion 119
  modifying position 123
  modifying size 123
  modifying speed 114
  modifying transparency 123
  shadows 117
 PiP track
  adding color boards 70
  adding images 69
  adding video 69
  description 66
 position of PiP effects, modifying 123
 PowerDirector
  interface 10
  modes 11
  new features 205
  versions 14
 Precise Cut in trimming 87
 preferences
  capture 17
  editing 52
 file 50
  general 50, 51
 pre-production
  ready to burn 10
 preview window
  Instant Preview 80
  previewing clips in 137
  previewing effects in 137
  previewing movie in 79
 Rendering Preview 80
 resolutions 80
 previewing
  clips in preview window 137
  effects in Media Editor 139
  effects in preview window 137
  in Media Viewer 139
  movie in Media Viewer 80
  movie in preview window 79
 producing
  AVC files 156
  AVI files 145
  before 143
  DivX files 150
  MPEG files 152
  PSP files 154
  QuickTime files 171
  RealVideo files 168
  WMV files 166
  your movie 141
 production
  mode 142
  profiles, AVI 160, 162
  Wizard 143
 profiles
  AVI 160, 162
  QuickTime 173
 program interface 10
project file
  create 48
  open 48
  properties 49
  save 48
project file, description 11
  properties
    of clips in Library 62
  project file 49
PSP
  producing 154
  producing files 154
restoring volume levels in audio
  tracks 97
restricting display of clips in Library
  59
ripping CD tracks 43
ruler, resizing 67

S
saturation, definition 220
save project file 48
saving
  Favorite files 183
scanning for intervals 29
scene detection 63
Scenes with moving objects 105
Scenes with people speaking 105
Scenes with zoom/pan 105
select clips in the workspace 73
setting
  chapters 76
  default durations 52
  master audio level 41
  Maximum undo levels 51
shadows
  in PiP effects 117
  in title effects 130, 132
size
  limit for captures 18
  of PiP effects, modifying 123
slide show 220
slides 220
slow-motion, adding to video 89
Smart Video Rendering Technology
  206
smoothing 164

Q
quality vs speed of video 164
quick erase 192
QuickScan 28
QuickTime
  file production 171
  profiles 173
R
realtime capture, definition 220
RealVideo file production 168
recording a voice-over 44
registration 5
removing
  clips from Library 60
  clips from workspace 75
renaming clips 61
replacing effects in Timeline 75
resizing the ruler 67

246
snapshot
  default destination 50
  default filename 50
  of video clip 88
sorting clips in the Library 59
SP quality 220
  video duration of 216
speed
  of PiP effects 114
  of video clips 89
  vs. quality of video 164
splitting clips 82
Standard Play quality 220
  video duration of 216
Storyboard view 68
streaming
  definition 220
  file production, QuickTime 171
  file production, RealVideo format 168
  file production, WMV format 166
  profile, QuickTime 173
stretching audio 90
SVCD
  interlaced video in 92
SVRT
  definition 220
  SVRT II, what is 206
  using in disc production 146
  viewing in project 78
  what is 206
  when available 207
system requirements 13
tape, writing to 175
technical support phone number 195
Template 181
templates
  in title effects 124
templates, downloading 182
time limit for captures 18
Timeline
  adding title effects 72
  adding transition effects 72
  adding video effects 71
  align clips 74
  hide tracks 66
  lock tracks 66
  unlock tracks 66
  view 65
title effects
  adding to Timeline 72
  animations 134, 135
  modifying font 125
  replacing in Timeline 75
  shadows 130, 132
  templates 124
Title Room 56
Title track
  adding titles 72
  description 66
tracks
  descriptions 66
  hide 66
  lock 66
  unlock 66
transition effects
  adding to Timeline 72
  replacing in Timeline 75
Transition Room 56
transparency of PiP effects, modifying 123
trimming
audio & video clips 83
dragging an edge 85
Precise Cut 87
video or audio 83
TV
capture options 20
capturing from 36
Type I AVI format, definition 221
Type II AVI format, definition 221

U
UI, default 10
uninstall your software 8
unlock a track in the Timeline 66
Update SVRT Info 78

V
VCD
description 213
versions of PowerDirector 14
video
adding to workspace 69
Magic Fix 105
Magic Style 107
overlay 17
size 173
video clips
detecting scenes in 63
snapshot of 88
video compression rate 163
video effects
adding to Timeline 71
modifying 113
replacing in Timeline 75
video qualities 186
hint on selecting 216
video duration of 216
video size 163, 173
video thumbnail 186
Video track
adding color boards 70
adding images 69
adding transitions 72
adding video 69
description 66
viewing
clip properties 62
project properties 49
SVRT information in project 78
Voice track
adding audio 71
description 66
voice-over recording 44
Room 44
Voice-Over Recording Room 57
volume
changing in Audio Mixer 96
changing in-track 95
volume keys
adding to an audio track 95
definition 221
W

webcam
  capturing from 40
  video capture options 22
website for technical support 194
what’s new in PowerDirector 205
where to begin reading 2
White Balance 99, 100
Windows AVI, producing 148
WMV
  definition 221
  file production 166
workspace
  adding clips to 69
  new 48
  Storyboard view 68
  Timeline view 65
write to DV tape 175

Z

zoom an image 103
CyberLink PowerDirector 5